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1. INTRODUCTION 

1.1. This document 

This document provides an introduction to the utilization of the dRofus program: installation, 
central terminology and navigation. The reader is expected to be familiar with navigation and 
use of Windows programs and with the working process for which the program is to be used. 

We recommend that all users of dRofus read through the entire document, or those parts 
which deal with the functionality the reader intends to use. We also recommend reading this 
guide at the same time as you have access to dRofus so that you can follow the explanations 
physically in the system and start trying out the different functions. 

The document is divided into parts which correspond to the program's functionality modules. 
You should read the parts which deal with the modules you intend to use. The first chapters 
contain general information such as installation and tips. The subsequent parts describe the 
following: 

1. General This part provides general tips on the use and installation of the program. 
Recommended for everyone. 

2. Room and functions This part describes central concepts such as room, room core 
information and functions. It also goes on to describe the requirements we place on 
functions (function program) and room (room data sheet).  

3. Items This part deals with the module for items in rooms, including existing 
equipment and rule checking for room data sheet (RDS). 

4. Finishes This part deals with use of the module for covering schemes.  

5. Logs and reports Joint functionality for the above-mentioned modules. Describes 
e.g. use of logs, reports and data export. 

A separate users' guide has been compiled for the procurement module: Procurement in 
dRofus. A separate guide has also been prepared for the technical information database 
(TIDA). In addition, a users' guide has been prepared for users with administration rights in 
dRofus. The most recent version of these documents can be downloaded from our website 
http://www.drofus.no. 

If you should find any errors in the document or any elements you feel are lacking, please do 
not hesitate to contact us! 

1.2. What is dRofus 

dRofus is an application and a database tool designed to support the room data sheet 
process and planning of items. The basic concept is to allow links between information on 
room data, room function data, finishes data and Items data in one common database. 
dRofus is a program which is independent of project and sector, and can be utilized for all 
types of building, irrespective of complexity. dRofus has been designed to allow major 
adaptations to an individual project, such that the program's functionality and appearance 
can vary from project to project. The program also adapts to the rights of an individual within 
a project, and will therefore look different for an equipment consultant and a room data sheet 
technician. 

http://www.drofus.no/
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dRofus is a client-server application where users work towards a central database server over 
the Internet. As such, several users can work on the same data at the same time, irrespective 
of geographical location and providing a highly flexible choice of workplace for users. 
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2. INSTALLATION 

2.1. System requirements 

General requirements 

 Minimum Recommended 

Operating system Windows XP Windows 7/8 

Memory 128 MB 512 MB 

Free disk space 50 MB  

Internet access Yes ADSL/SDSL or other permanent Internet 

connection. 

Other programs Adobe Reader MS-Excel for Excel export 

MS-Word for Word export. 

 

The program has been designed and tested for the more recent versions of Windows. All 
functionality will therefore not be available in the older versions of Windows. 

No data is stored locally on PCs, but on a server so that all users can immediately view any 
changes made to data. This implies a lot of data transfer by Internet  the quicker the 
connection you have, the faster the data is transferred. As a user, you will have to remain 
connected to the Internet at all times while using the program. 

Ports 5432, 80 and 8180 must remain open if the program is to function properly. 
Certain firewalls may therefore obstruct the program. Contact your local IT 
Administrator if you experience problems with log in.  

Other programs 

All reports generated by dRofus are created as PDF (Portable Document Format). You will 
therefore need Adobe Reader to read and print these reports.  

Adobe Reader is free software and can be downloaded from Adobe's website: 
http://www.adobe.com/products/acrobat/readstep2.html 

In order to utilize the data export function to Microsoft Excel and Microsoft Word format, you 
will need to have these two programs installed on your PC. Ref. paragraph 18.1 

2.2. Installation 

Download the most recent version of dRofus 

The most recent version of dRofus is available at all times from Nosyko's website for 
dRofus: www.drofus.com 

http://www.adobe.com/products/acrobat/readstep2.html
http://drofus.no/en/support-services/download.html
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Install dRofus 

After the download has completed, you run the installation program (double-click the 
downloaded file entitled drofus-setup.exe) and follow the onscreen instructions. 

Once this has been completed, you can start the program from the start menu. 

Uninstall 

If you want to uninstall dRofus, you just choose "Uninstall dRofus" from the dRofus directory 
in the start menu.  

2.3. Automatic software updates 

Every time you log in to the program, dRofus will check whether new versions of the program 
are available. If so, you will be given the option to install the most recent version. We 
recommend that you click "Yes" when given this option, as the most recent versions will 
contain new functionality and error recovery. Please note that if you have Windows Vista 
installed, you will have to start dRofus as an Administrator in order to update the program. 
Downloads of the most recent version do not normally take a long time. 
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3. GENERAL INFORMATION ON UTILISATION OF THE PROGRAM 

3.1. Log in 

When you start the dRofus, you will be asked to log in to a project. You need the following 
information to do this: 

User name/password: You will receive a personal user name/password from dRofus or the 
project administrator. Please do not utilize  user name/password or allow 
others access to your user name/password. They are required for reasons of security and 
because the program provides functionality according to user rights. In addition, the 
amendment log is based on your private identity. 

Once you have logged in, you can change your password by going to the menu for dRofus -> 
Change password. Or go to http://www.drofus.no/en/support-services/forgot-your-
password.html to generate a new password (if forgotten).  

Server: This is the IP address or name of the server to which you want to connect. Normally, 
this will be db2.nosyko.no or db.drofus.com, unless your project has installed dRofus on its 
own server. Please refer to the server information in the email you received when you were set 
up as a user in the project. 

Database: This is the name of the project database you want to log in to. You will have 
received this information together with your user name/password. It is most likely to be an 
abbreviation of the project name. 

Please remember that you have to remain connected to the Internet at all times when using 
the program.  

3.2. Language 

dRofus supports several languages. When you install dRofus, you have the choice of standard 
language for the program. You can also change standard language by going to dRofus-
>Settings. However, in dRofus each project has its own standard language, irrespective of the 
language you have selected as a user, as most projects require background text and data 
entered in the program to be in the same language. When you log in to a project which has a 
different language than that chosen by you as user, the program will ask if you want to 
change to the project language. We recommend that you accept this choice.  

3.3. Navigation 

In general, navigation in the program is very similar to normal Windows navigation. However, 
below are a few helpful tips to remember: 

Menus and toolbars 

The menu bar will show you all 
current functionality for the window 
you have open. The main parts of the 
project, such as room list and room 
templates list, are located in the 
Project menu.  

Right-click: When working in lists, 

Figure 1: Example of options in right-click menu 

 

http://www.drofus.no/en/support-services/forgot-your-password.html
http://www.drofus.no/en/support-services/forgot-your-password.html
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e.g. room lists, the quickest way to access functionality for a specific room is to right-click on 
the room in question. All functionality is also available from the main menu bar and some 
functionality has short-cut keys. You can often open the right-click menu by pressing down 
SHIFT+F10 or using the special key for this on a Windows keyboard (often between CTRL and 
the Windows key on the right-hand side of the keyboard). 

Use of lists 

When working with large lists (such as the room list), it is often beneficial to sort the data by 
a specific column. You do this by clicking on the title at the top of the list in the field you want 
to sort by. If you click on the same title once more, the list will sort in the reverse order. For 
example, you can sort a room list in alphabetic order by room name by clicking on the title at 
the top of the room name column.  

You can also reorganize the column order in all lists. To do this, click on the title of the 
column and drag and drop it into a new position. This will be saved by dRofus and displayed 
every time you use the system. If you want to reset to the original column order, all you have 
to do is right-click and select Add/Remove columns and Restore default. 

Some of the lists (such as the room list) allow you to select several rows at a time then run 
a function on all simultaneously.  

 

Figure 2: Example of link between room and room templates 

It is also possible to select several rows at a time by clicking on the first row you want to 
select, then press down and hold the Shift key and click on the last row you want to select. If 
you want to select several rows which are not necessarily in consecutive order, you can press 
down and hold the Ctrl key while you click on the rows you want to select. This can also be 
combined with the method above. Once you have selected a number of rows, you can right-
click on one of the selected rows and choose the function to be run. The example above 
shows a user who wants to link five rooms so they have the same RDS from the same room 
template. Instead of performing this operation for each office at a time, the user selects all 
the rooms and then runs the function as normal. 

When working in lists, the most common selection is normally opened by clicking RETURN 
when an element is highlighted. There are a number of short-cut keys in special windows (ref. 
3.5) 

All lists in the program can be exported to MS-Excel by pressing Ctrl+E while elements are 
highlighted in the list.  

Users can also adapt a number of the most important lists in the program by right-clicking on 
the list and selecting  

Add/Remove columns.  



USERS' GUIDE, DROFUS 

 

 

 
15 

This will open a dialogue box similar to the one on the right, depending on which list you are 
working in.  

The system will remember the choices you 
make here and save them until new changes are 
made. The "Restore default" alternative will 
reset your changes back to the predefined 
columns. 

Some of the columns may result in slow 
searching and navigation in the lists. These are 
marked in orange. This will not always be that 
noticeable, but if you have a high number of 
items in the Items window, the list may be 
slower. 

Navigation backwards and forwards 

Most detail windows (RDS, equipment in room, Item specification, sub Items etc.) have 
buttons for navigation forwards and backwards. These allow the user to open information in 
the next or previous room/Item in the underlying list - the list from which you opened the 
window. If, however, you click on the small arrows at the bottom on the left and right hand 
sides of the window, you can choose to move up to four steps in each direction (see figure). 
You can also use the ALT+Right/Left keys to navigate without using your mouse.  

For example: Two detail windows can be 
opened from the room list; equipment in room 
and RDS. These both have navigation keys for 
backwards and forwards, but will have different 
significance. Both will take you forwards and 
backwards, depending on how the room list 
has been sorted (ref. paragraph above). The 
Next button will take you to the next item in the 
room list. If the list is sorted by room function 
number, the next room will be the next "valid 

room" in accordance with the 
room function number. If 
however you choose to sort the 
room list by e.g. room name, the previous/next buttons will take you alphabetically through 
the rooms displayed in the room list. The term "valid room" is defined as the next room with 
the requirements for which you are searching. For Equipment in room, you can navigate 
between the rooms for which an equipment list has been established. However, in a RDS 
window, the Next button will take you to the next room in the room list for which RDS has 
been established. When you click on the small arrow beside the previous /next button, you will 
see a drop-down menu where all "non-valid" rooms are grey and not available. 

When you close the underlying window, you will no longer be able to navigate forwards and 
backwards and these buttons are no longer available. 

Export of lists to Excel/Word 

All lists in the program can be exported to MS-Excel and MS-Word. Highlight the list you want 
to export and press either CTRL+E or CTRL+W for Excel or Word respectively. You will need to 
have Excel/Word installed on your PC to do this. 

Figure 4: Rooms without RDS are not available 

Figure 3: Add/Remove columns 
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3.4. Formatted text and use of hyperlinks 

dRofus provides the option for use of formatted text for all text fields. A formatted text field 
differs from an ordinary text field in that you can see the formatting choices above the actual 
text field. These formatting choices include bold, italic, underline, bulleted list, numbered list 
and color. You can also enter hyperlinks for websites and local files. Please note that you have 

The hyperlinks will also be active in the PDF reports generated by dRofus. 

Formatted text fields can be implemented in all forms in dRofus such as RDS form, Item 
window, function program, finishes and procurement module. If you want help in entering 
formatted text fields, please contact the project administration or dRofus support. 

3.5. Short-cut keys 

The majority of windows, particularly trees and lists, allow navigation without using your 
mouse. Below is a list of general short-cut keys and short-cut keys for special windows. 

General  

F5 Refresh the list 

TAB Go to next field/window 

SHIFT+TAB Go to previous field/window  

CTRL+P Print 

RETURN Open highlighted element in a list 

ALT+right/left In windows which have navigation forwards and backwards, move to 

previous/next 

Arrow keys in a tree window Navigate in the tree window 

SHIFT+arrow keys Navigate in the tree window without refreshing the list (quicker!!!) 

SHIFT+F10 Open the right-click menu in lists (can also use special keys) 

CTRL+F4 Close active window 

CTRL+TAB Change active window (circulates between open windows) 

ALT+F4 Close program 

CTRL+E Export a list to MS-Excel 

CTRL+W Export a list to MS-Word 

  

The room list  

SHIFT+arrow keys Navigate in the tree window without refreshing the room list  

RETURN Open RDS 

SHIFT+RETURN Open room core 

CTRL+RETURN Open equipment list 

 

 

F3 Go to search field 

  

Item overview  

RETURN Open Item 

SHIFT+arrow keys Navigate in the tree window without refreshing the room list 

 F3 Go to search field 

  

RDS/Item window  

ALT+Up/down Move to previous/next flag/tab in RDS/Item specification 

ALT+right/left Move to previous/next room 
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3.6. Settings  

Users can specify a number of their own settings from the program. You may not have to 
change these settings, but it is useful to know about them. 

Open dRofus -> Settings. In this menu, you can change the following: 

 Confirm on exit: If this is marked, you will be asked to confirm when you close or end the 
program. 

 Language: Choose the standard language you want dRofus to start in. Please note that 
the program will ask you to change to the project language, irrespective of this setting. 

 Clear user settings: You can delete all saved settings such as advance selections for 
server and database when you log in.  

 Clear saved window sizes: Delete the window size setting which is "stored" from time to 
time. This will also restore settings for recommended/predefined column width, position 
and which columns are to be displayed. 

 Delete local IFC models and 3D files for this project: Deletes pre-loaded models and 
viewer files in the project you have logged in to from your computer. 

 Delete all local models and 3D files, including downloaded 3D models: Deletes all 
pre-loaded models and viewer files from your computer.  

 Skip confirmation when adding room: Eliminates the security question when you 
create new rooms in the room list. 
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PART 2: ROOM AND 
FUNCTIONS 

MODULES FOR ROOMS AND AREA PLANNING, AND ROOM DATA SHEET 
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4. ROOM AND ROOM CORE INFORMATION 

4.1. Introduction and definitions 

The most central concept in the program is a room. The rooms are placed within a functional 
structure, as parts assembled to make up functional units. This structure most often has two 
or three levels. The functional position of the room is not directly linked to the room's 
geographical position and location. 

The room is identified using a unique room function number. This number stays with the room 
throughout the building project, and the number is never re-used within the same project for 
another room. The room function number is composed of the room's position within the 
functional structure in addition to a serial number, e.g. room no. 01.01.001 will be positioned 
as follows: 

 

Only users with administration rights are permitted to permanent delete a room. In general, 
rooms which have been created are seldom deleted, but can be marked as deleted if they are 
no longer to form part of the project. If a room is to be moved to another part of the structure, 
the user will be asked whether he/she wants to mark the original room as deleted and create 
a new room with a new room function number. You will also have the choice to move the 
room. This operation should not be utilized when the room function number is being used by 
the project, as the old numbers may be re-used.  

The room has a number of central qualities which are described in the room core information. 
This is information such as: Room function number, name of room, description of room, other 
room numbers (drawing number, designed/geographical room number and use room 
number), the programmed area (the planned size of the room) and the designed area (the 
final size of the room as drawn by the architect).  

Changes to the room's core information and other significant changes to the room are 
entered in a log known as a room log.  

The room is linked to other information, such as room data sheet (RDS) and equipment list. 
This is information not normally assigned to a room, but which has to be created for each 
room. These concepts are explained later in this document.  

4.2. Create room and function structure 

There are several ways in which to create a room list in dRofus. You can manually create a 
function structure and room from the room overview, you can import from Excel or Revit, or 
you can create a room from an IFC model. The program's IFC functionality is described in 
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detail in a separate users' guide available at www.drofus.no. The process to import a room list 
from Excel is described in chapter 19. 

Manual creation of room and function structure 

Before you can create a room, you have to create a level (function) under which the room can 
be entered. To create a level in the function structure, right-click on the project name in the 
room overview and select New department (ref. figure 5). This selection may have different 
names depending on the project. You can also carry out this operation to create sub-levels. 
You will need the necessary rights to perform this operation. The depth (how many levels on 
top of each other) of the structure and the names of the different levels (department, section 
etc.) are set by the project administrator.  

 

 

Rooms can only be created in levels which do not have sub-levels - i.e. you have to be at the 
lowest level to create a room. When you add a room (Add room from the toolbar), you will see 
a room core window where you enter core information under the list of rooms. The next 
chapter contains more detailed information on the interface in the room list. All other 
functions available for a room can be found by right-clicking in the room. If you mark a room 
as deleted, the rooms' designed area will be set to zero and all linked information (RDS, 
equipment, finishes) will be deleted. 

4.3. Move or copy functions and sub-functions 

When you have created a function or sub-function and wish to move or copy it to another 
location you can achieve this from the room overview. Right click on the function/sub-
function you want to move/copy and you  

 

Figure 5: Create function structure 

http://www.drofus.no/
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 Move: Move selected function/sub-function to another function in the same project 
or to another project in the database  if there are more than one projects in the 
database. 

 Copy: Copy selected function/sub-function to another function or sub-function in 
the same project or another project in the database. 

When you move or copy a function or sub-function all data will also follow; rooms with RDS 
and equipment data, function program and images and documents. 

IF you e.g. move a sub-function up one kevel so it becomes a function you will need to give the 
sub-function a new number if there already exist a function with the same number. 

To move of copy function/sub-functions you nees write access to rooms. 

4.4. Room overview 

The primary mode of access to a room is via the room list, which can be opened from the 
Project -> Rooms menu or the start window. On the left-hand side of the window, you can see 
the project's function structure (functions and sub-functions). If you select a level, you will 
see all the rooms under this level and its sub-levels in the list on the right.  This list displays 
the room's function number and name, area and status for RDS, equipment and finishes. This 
is explained later in this document. 

 

Figure 6: Example of interface in the room overview 

On the left-hand side of the room overview, you will see two tabs; Functions and Groups. The 
Functions tab contains the function structure while the Groups tab displays the room groups 
defined for the project. The method for linking rooms to groups is described later on in this 
chapter. 

By marking a function in the function structure, you will see all the rooms under this function 
in the list on the right. If you click on Open, just above the rooms, you can choose to view the 
room's RDS, Equipment in room, Room core information. If you select RDS or Equipment in 
room, the system will open the respective windows for RDS and equipment. However, if you 
select room core, the screen will split into two. At the top of the screen you will see the rooms 
from the function selected. At the bottom, you will see the room core information for the room 
selected in the room list. 
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The number of rooms and area number are displayed in the status bar at the bottom of the 
screen. If you select multiple rooms in the list the status bar will summarize the selected 
rooms showing number of rooms selected and total of programmed and designed area for 
the selected rooms. 

A status icon is displayed in front of each room. These have the following definitions:  

Icon Definition 

 

The room is not linked to any RDS form 

 

The room is linked to an RDS form 

 

A comment/note has been registered for this room 

 

The room has been marked as deleted  

 

In general, the room list does not display deleted rooms. If you want to view deleted rooms in 
the list, select Show deleted rooms on the toolbar.  

Note/"Post-it" for room  

Users can attach a comment/note to a room. If a comment has been attached to a room, it is 
displayed by an icon ( ) in the room overview. The note is also displayed in the RDS window 
and equipment list. A note can be changed, deleted or created by right-clicking on the room 
and selecting "Note" or by going to the "Note" tab in the room core information. 

Search 

The "Search" button opens a search dialogue box. If you want to perform a simple search by 
e.g. room or room function umber, you can use the quick search function, see below. 

 

Figure 7: Search dialogue box 

In the search dialogue box, first select the field you want to search in by opening the first 
drop-down menu. If you select RDS or covering specification, you can also select individual 
fields in RDS or finishes. Once you have selected the field, you then go on to select the search 
criteria and values, such as Greater than 100 or Equals Yes. You will be provided with a 
number of choices, depending on whether the field is a digit, Yes/No field or text.  
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You can add more criteria by clicking on the plus sign beside the bottom criteria. If you want 
to remove a criterion, you can click on the minus sign. At the top of the screen, you can specify 
whether you want all the criteria to be met or if it is sufficient with just one.  

You can save a search to be used later. Click on the Save button and give the search a name 
you will recognize. You can then re-open the search from the drop-down menu at the bottom 
of the screen or directly from the room list by clicking on the search button drop-down menu. 

There are two types of criteria for text 
which require detailed explanation: 

Pattern: The pattern option allows you to 
create a more precise search function 
where you can use the ? and * characters 
as wildcards to represent a random 
character or several random characters. 
You use the | character to denote or group 
expressions with brackets. The search 
code S1??(N|M)* will provide all results 
which start with S1 and have either N or M 
as 5 characters. Not pattern means 
everything with the exception of search 
results. For example, *BA will return all 

which do not end in BA. 

Regular expression: Using regular expressions, you can create extremely advanced 
search expression using pattern in text. Documentation of this is available: here:  

You can also search for rooms that . In the 
Choose search fields drop down you can search for equipment status, last modified, as well as 
Item specifications.  

Quick search in the room list 

At the top of the toolbar is a search field where you can search for rooms (you can also press 
F3 to open this field). When you use this search function, rooms which contain the word you 
search for either in the room name, room name description, room function number, 
designed/geographic room number, room use number and extra room core fields will be part 
of the result. In other words, if you search for "office", the result will include "Office workplace", 
"Workplace, office" etc. If you search for "01", the result will be rooms which for example have 
room function number "01.01.001" or "02.03.012" or geographic number "042101". 

Printing 

 The room list can be printed out by clicking on the print button on the toolbar. This prints out 
the function you have currently selected. If you want to print out all rooms, right-click in the 
function structure and select Print. This will open a dialogue box as shown in figure 8. The 
dialogue box allows you to enter limitations at room level, and if necessary, to add rooms and 
areas. The sorting and selections you have made in the list will not be made to the report. If 
you want to make other selections and sorting, go to the report overview and select 
Room>Room list. You can also use the Room>Function structure report to obtain the area 
number under each function. 

Figure 8: Dialogue box for printing rooms to PDF 

http://www.postgresql.org/docs/8.1/interactive/functions-matching.html#FUNCTIONS-POSIX-REGEXP
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4.5. Room core information 

Room core information is displayed and can be changed by selecting Open->Room core from 
the menu or selecting a room and using the short-cut keys SHIFT+ENTER. 

  

Figure 9: Fields in the room core may differ from project to project. 

The room core contains a set of information which is unique for each room in the project. The 
room's function number is automatically assigned by the system according to the function 
under which you have placed the room. The room function number is the most important 
piece of information in the room core and identifies the room. This number will never be re-
used and follows the room for its entire life cycle.  

Room name and room name description 

It is essential for a project to maintain consistency when naming rooms. dRofus has 
functionality to help with this. A room can be named using two fields, name and name 
description. The intention here is to provide the room with a general name, such as "Office", 
"WC" etc. to allow simple searches for rooms of the same type. Subsequently, a room is 
assigned a more specific description, such as "1 person" and "Ladies" so that the complete 
room name is "Office, 1 person" and "WC, Ladies". The rooms will be displayed like this in all 
lists and reports, i.e. "room name, room name description". Room names are selected from 
the drop-down list. If you do not find the room name in the list, check whether the project has 
other names in use. If not, type it in. When you save, you will receive a message stating that 
the name will be entered in the list of permitted room names. When you have selected a room 
name, the list of room name descriptions will display the descriptions which are relevant for 
the room name chosen. Choose one of these or type in a new one. If you enter a name 
description which has not been used before together with the selected room name, you will be 
asked if you want to add the description to the list of suggestions. Ref. also chapter 4.5 Room 
name manager. 

Areas and measurements 

A room has a number of unique areas and dimensions. The project will define which and how 
many of these are to be used in addition to the standard: Programmed and designed area, 
perimeter and ceiling height. Note that the parameter Programmed Gross Area is a read-only 
parameter showing the programmed area multiplied by Programmed area Gross/Net factor 

 4.8). 

Change room core information in several rooms 

If you want to change room core information in several rooms, you can perform this as one 
operation. Select the rooms in the room list you want to change by holding the SHIFT or CTRL 
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keys down while you select with the mouse. Once you have done this, you will see check boxes 
in front of the fields in the room core. To change a field, you have to check the field you want 
to change and type in the required value. Then click on the Save button. You have now 
specified a new value for the rooms you have selected.  

NB! When you change room core fields for several rooms at a time, you enter the same 
value for this field for all rooms. If you are uncertain what the old value was, select a 
room, right-click and go to room log. 

4.6. Room name manager 

You can use the room name manager to view and change the room names, room name 
descriptions and drawing names used in the project. Go to the Project->Room name manager 
menu. 

 

 

Figure 10: Room name manager 

As described in chapter 4.5, the name of a room is composed of the combination of room 
name and room name description. At the top left, a list of the room names utilized is 
displayed, with the number of rooms and number of room name descriptions in addition to 
the drawing names. When you click on a room name, the room name descriptions registered 
under the room name are displayed in the list at the top right. When you click on a room name 
or a room name description, you can see the room with this room name and any room name 
description in the list at the bottom. Right-click on a room name or a room name description 
to view the following options: 

 Edit - Allows you to change room name and drawing name. All rooms which make use of 
this name will automatically be assigned the new name. 

 Add  Allows you to add new names which come as suggestions when creating a room. 
 Delete  Deletes the name. If the name is used by a room, these will have a blank name 

or name description. 
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 Update  Updates the list from the database. This can be useful if you make a lot of 
changes to names or merge names. 

 
If you select several names, the only option available is Delete. This can be useful in 
connection with sorting a number of rooms in order to delete names which are no longer in 
use. Room names which are only different because of blank (space) or different use of upper 
case and lower case letters will appear as orange in the name list. This is to enable you to 
detect errors which have occurred in name use. 
 
By selecting and right-clicking on one or more rooms, you are also able to change the room 
name and room name description used for the selected rooms. 

Merge room names 

If you change a room name to one which already exists, the system will ask you if you want to 
merge these room names. If you answer Yes, all the rooms will have the same name and any 
name descriptions assigned to the room name you changed will be transferred to the new 
room name. 

4.7. Groups 

There are two tabs in the room list; Functions and Groups. Under the Functions tab, the rooms 
are structured according to function. Under the Groups tab, there is the option to group 
rooms according to other criteria such as user groups, safety zones, leases. Other examples 
of group types may be building phase, floor level, wing etc. There are no limits in the program 
for the number of group types created or the types of groups created. Groups are therefore a 
flexible tool for projects where it is preferable to group and maintain an overview of rooms 
based on other criteria than the function structure. 

Create group type  

Group types and groups are created under the tab "Groups" which you will find beside the 
"Functions" tab in the room list. To create a new group type, right-click on "Groups" and select 
"New group type". You then have to assign a name to the group type. There are two tabs in the 
window on the right; Group type and Room. Under Group type, you can add a description of 
the group type, classification (see IFC user guide). In the field below, you can link RDS 
requirements to the group. Room groups and requirements are described in detail in chapter 
7.7. 

Create group 

To create a group, right-click on the group type and select New group, then give it a name. 
You will now see two different tabs in the window on the right. The Room tab provides you with 
an overview of the rooms linked to the group you have selected. At the bottom of the window, 
you will see a summary of the number of rooms and total area for the rooms linked to the 
group. The next tab displays the RDS fields defined for the group. Chapter 7.7 provides more 
detailed information on groups and requirements. 

Group overview 

When you select a group type in the tree structure, you will see both the properties of the 
group type and a list of groups on the right side. This sums the number of rooms and spaces 
for all the groups and gives possibility to set a reference and color for each group. This is most 
interesting when used in combination with the IFC / BIM (see separate guidance for IFC 
support in dRofus-> Groups) 
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Link rooms to groups 

Once the groups have been created, you can start linking rooms to the different groups. You 
can do this in a number of ways: 

 The Add room button is in the menu under the Room tab. You can pick a room from 
the room list or search for a room using the search field. 

 Another option is to search for a room using the Quick search or dialogue box for 
more advanced searches (ref. chapter 4.3). Once you have found the room, you can 
select it by using the SHIFT and/or CTRL keys then right-clicking on one of the 
selected rooms and selecting Add to group.  

 The last option is to link rooms to groups from the room core window. The group 
types created will be displayed in the room core window under Groups. You can 
select one or more rooms and link them to a group in one operation. 

NB! A room can only be linked to one group within the same group type, but can be 
linked to several different groups as long as the groups are in different group types. 

Groups in reports 

Once you have grouped rooms, there are several different reports which can be generated for 
the different groups. This applies for example to the report for Equipment in room, RDS - 
Room data sheet, Finishes, Cost calculations per room group etc.  

For example: A project has to find the budgeted value for Items in different areas in 
the building. You can create a group type with the name "Budget" for example, create 
groups under this group type with the names of the different areas and then link the 
rooms to the groups. You then go to Reports and exports ->Calculations->Cost 
calculations per room, select group type "Budget" and generate. 

4.8. Area overview 

The room overview also has the Areas tab which provides a summary of all areas, depending 
on your position in the tree on the left-hand side. If you are in the project, it will provide you 
with a summarized overview of all functions, with sums of programmed area, designed area 
and difference between the two. When connected to an IFC model you can use assign 
different levels to a color of your choice. The image beneath shows the areas tab. 
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Figure 11: Area overview with model connection 

When you select a function/level in the area tab you will see additional area fields below the 
area overview. Here you can edit the area values for the function/level you have selected.  This 
works similar to the Graphical function planner which is described in chapter 9.6 

 

project areas will not show, only areas 
for underlying functions/levels.  

When you select a function a menu appears beneath with the possibilities to edit area values 
for the selected function. There are three different area values: 

 Function planner areas: Used for planning of functional areas before a room list is 
created. Values can be set in the area tab or be transferred from the Graphical function 
planner (chapter 9.6) 

 Programmed areas 
 Gross: Calculated from the net programmed area for the rooms multiplied with the 

Gross/Net factor 
 Net: Sum of net areas for the rooms in the function 
 Gross/Net factor: Used for calculation of gross programmed area. 

 Designed areas 
 Gross: Can be set manually or synchronized from model 
 Net: Sum of designed areas for the rooms 
 Gross/Net factor: Used for calculation of gross designed area. 

 

You can apply a color for each function. When attached a 3D model colors help identify rooms 
connected to the function. 
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5. REQUIREMENTS FOR ROOMS AND FUNCTIONS 

5.1. General information on setting requirements in dRofus 

dRofus allows users to set requirements at different levels. 

Function program  

This is where you can set requirements for the project and functions/departments. These 
requirements have no direct link with the requirements at room level and cannot be inherited 
downwards. These are requirements on the function in total and not directly for all rooms. The 
current mode of utilization involves a number of text fields or formatted text fields (ref. 
chapter 3.4). Function program is described in chapter 8.  

Room data sheet  

This is where you set requirements for the individual rooms by using: 

 Room templates 

 Templates (we recommend using room templates, use of templates must be 
activated by the project administrator) 

 Groups 

 Unique RDS 
 
A common feature for room templates, templates and groups is that they provide tools for 
setting requirements for rooms (which apply to individual rooms), but which can be changed 
at a principal level. If you make a change to a room template, template or requirement group, 
you are actually making a change to numerous rooms.  
 
Another major benefit when using room templates and requirement groups is that you can 
start to work on these concepts at an early stage of the project, even if the room list has not 
been compiled. This is also information which can be extensively re-used by multiple builders. 

Room templates: You can set joint requirements for several rooms by using room templates. 
You would use this if you need several rooms of one type for a project, possibly for several 
functions. Room templates are described in chapters 6.1 and 6.2. 
 
Requirement group: You can set joint requirements for parts of the room (parts of the RDS 
form) which are common for several rooms, possibly for just one discipline, applicable to all 
room templates. The use of requirement groups is described in chapter 7.7. 
 
Unique RDS: This means that the room's requirements are unique, i.e. not linked to a room 
template or template. Please note that a unique room may still be subject to requirements 
from a requirement group. More information on RDS is provided in chapter 7. 
 
 



USERS' GUIDE, DROFUS 

 

 

 
30 

6. ROOM TEMPLATES 

6.1. Introduction and definitions 

Room templates 

Room templates are fictive rooms which are used to create templates for information to be 
linked to rooms, allowing for re-use of RDS and Item information when rooms are identical or 
practically identical. The room templates contain key information just as a room has core 
information, but this is never used directly as the room template is not an actual room. The 
information is intended as descriptive for links to the room. If you create two standard 
meeting rooms, one covering 20 square meters and one covering 80 square meters, the area 
defined will provide information on the difference between any RDS and equipment 
information linked to these rooms and what type of room this information is intended for. 
Room templates are described by a name, a description and a programmed area. As they are 
fictive rooms, they will not have a designed area. They have room history and status 
information just as with normal rooms. Room templates are not placed in any type of level 
structure but have a unique room template number just as with normal rooms. This is only a 
serial number. 

Room templates are used to create templates for: 

 Room data sheet - RDS 
 Equipment in room 
 Finishes 

RDS, finishes and equipment information are automatically linked to the room templates. 
They do not have to be generated as for normal rooms. 

A room can be linked to e.g. an RDS template. This can be performed in a number of ways, 
described in more detail under RDS in this document. If a room has RDS information directly 
from a room template, the changes to the room template's RDS will be reflected in all rooms 
linked to the template. 

Templates 

As previously mentioned, room templates are used to create standardized RDS, finishes and 
equipment lists for the entire project, such as offices, toilets etc. However, major projects may 
require numerous rooms which are identical but are not to be known as room templates as 
they are not standardized throughout the project. These could for example be special rooms 
within a specific department. Despite this, a template is still required when you have two 
identical rooms because you can then update the template and know that all rooms which are 
meant to be alike will be alike. To do this, you can create templates, either equipment 
templates, covering templates or RDS templates. As opposed to room templates, templates 
are of a specific type and no equipment is linked to an RDS template or vice versa. Neither do 
templates have other core information than a code and a name. 

Templates are primarily used for major projects, where the number of room templates will be 
high and difficult to maintain in an overview.  
 

6.2. Room templates/templates in dRofus 

Room templates are normally accessed from the room templates list (Project -> Room 
templates). An example is illustrated in the image below. As in the room overview, you can 
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access all functionality regarding the room templates by right-clicking on a room template. 
The core information on the room templates is displayed on the right-hand side and the 
subsequent tab windows display a list of rooms which have RDS, finishes or equipment from 
this room template. The Print button provides a list of all room templates. From the room 
templates window, you can also link the individual room templates to different requirement 
groups which are defined for the project. The yellow note field can be used by users without 
writing access. 

  

Figure 12: Room templates window 

You can also search in the room template list using the search field. 

From the room template menu you have following options; 

 New Room template: Create new room template 
 Delete room template: Will delete selected room template 
 RDS: Opens the room template room data sheet (Will only show if you have access to 

rooms) 
 Equipment: Opens the room template equipment in room (Will only show if you have at 

least read access to equipment) 
 Finish: Opens the room template finishes (Will only show if you have at least read access 

to Finishes) 
 Room log: Opens the log for selected room template 
 Print: Exports a list of the room templates to PDF. 
 

To copy a room template, right click on the template you want to cop
template . 

6.3. Templates in dRofus 

Templates are accessed via the RDS template window (Project -> RDS templates) and the 
equipment template window (Project -> Equipment templates).  
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These windows have a list of all templates on the left-hand side. You can add new templates 
and delete templates in this window. When you add a new template, the system will ask you to 
specify a prefix and a name for the new template. The prefix is the letter or number in front of 
the template's serial number, .e.g. for K.020 the prefix will be K. It can be beneficial to assign 
different prefixes to different rooms, making it easier to distinguish between them. The serial 
number will be generated automatically by the system.  

If you right-click on a template and select Dependent rooms, you will see a list of the rooms 
which are connected with this template. 

On the right-hand side of the same window, you have access to editing the RDS and 
equipment list for the relevant templates. 
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7. ROOM DATA SHEET (RDS) 

RDS information describes functional and constructional engineering requirements for a 
room. RDS information will be linked to a room or a room template. 

A room template will always be linked to RDS. This implies that a room template can be 
utilized as a template by creating RDS for a room. For more information on room templates, 
read the chapter above. 

In dRofus, a room can have four different statuses for RDS: 

 Not created i.e. no requirements set for the room 

 From room template - the room has the requirements from a room template 

 Derived from template- the room has the requirements from a room template but 
with deviations 

 Unique - the room has unique requirements 
 
It is possible to switch between these different types for use of room templates throughout a 
project. The chapters below describe the different statuses for RDS. 

7.1. RDS from room templates 

The fact that a room has RDS from a room template implies that a room has all its RDS 
information from a room template. These are rooms of which you will need several in a 
project, possibly used in several functions. It implies that it is not possible to edit RDS directly 
from the prevailing room, but RDS must be edited in the room templates for which it is 
inherited. This means that when you change information in RDS connected to a room 
template, the RDS will change for all rooms which have RDS from this room template. RDS 
from a room template will therefore be used for rooms which have common constructional 
engineering requirements. 

One of the major benefits with room templates is that they are standard. In other words, a 
room template defines all the requirements for a room. For a major project with numerous 
rooms, the system will allow users to recognize and remember normal room templates. If you 
note that an office has RDS from room template RT.001, you then know the requirements 
which apply for that room - you don't need to dig into the details. Moreover, this is a quick way 
of programming and for quality assurance to ensure that all rooms intended to be identical 
are identical. The illustration below displays how the functionality for use of room templates 
(in this case an office) works. 
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Figure 13: RDS template 

7.2. Derived RDS 

If you have a room which has all the requirements connected as in the room template, but you 
want to make some changes to the actual room, you can create a derived RDS. This means 
that the requirements still come from the room template, but that it is possible to overwrite 
the data you want to be unique. This is displayed in the program when you open the RDS. The 
unique requirement is only displayed for the selected room, while the other requirements 
come from the room template. If you make a change to the room template, this will also be 
updated for the room as long as it is not one of the values you have overwritten. The figure 
below attempts to illustrate this, where a room has the majority of requirements from the 
room template (in purple) but certain unique values have been overwritten (in white). 

 

Figure 14: Derived RDS 

Example of difference between derived RDS and RDS template:  

Take a room template SR.001 which only has two pieces of information: The number of 
telephone sockets is 1 and the number of fax sockets is 1. We then let room R1 have 
RDS information derived from S1 and R2 have RDS information from S1. In R1, we then 
set the number of fax sockets to 0. Then we set the number of telephone sockets and 
the number of fax sockets to 3 in S1. The result is that room R1 (derived) will have 0 fax 
sockets and 3 telephone sockets, while room R2 will have 3 telephone and fax sockets. 

Temp. max: 25 c 

Temp. mim: 19 c 

Single outlets: 4 

Description: Work space for one 

person  Min.door opening: Wheelchair 

Occupancy: 2 persons 

Permanent workspace: Yes 

Daylight: Outer wall 

Wireless network: Yes 

RT.001 
Office, 

1 person 

(Room template) 

01.03.050 

Office 
RDS: From RT.001 

01.02.003 

Office 
RDS: From RT.001 01.03.004 

Office 
RDS: From RT.001 

Temp. max: 25 c 

Description: Work space  

Temp. mim: 19 c 

Min.door opening: Wheelchair 

Permanent workspace: Yes 

Occupancy: 2 persons 

Daylight: Outer wall 

Wireless network: No 

Single outlets: 3 

RT.001 
Office, 

1 person 

(Room template) 

01.03.004 
Office 

RDS: Derived from 

RT.001 
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7.3. Unique RDS  

This implies that the room has links to RDS requirements, but that these are unique for this 
room. If you want to make a change to 10 rooms which have unique RDS, you have to make 
the change to each of the 10 rooms. This applies to rooms which have such special 
constructional engineering requirements that it is not appropriate (time saving) to share 
information with other rooms. 

 

Figure 15: Unique RDS 

7.4. Creating and deleting RDS connection 

From the room list (Project -> Rooms), you can link RDS to a room as follows: 

 Select the actual room in the room list, or select several rooms by using the Ctrl/Shift 
keys as described in chapter 3.3 

 Right-click then go to RDS and choose the connection you want, or choose Room -> RDS 
from the menu then choose the connection you want. You can copy RDS status and 
values from  

 You can connect a room to a template RDS and template equipment lists in one 
right click menu. Select 

what you want to be created from the template and select which room template to 
connect to. In the dialogue window you can also chose to copy room name and 
programmed area from the room template to the rooms you have selected. 

 If you want to delete RDS, follow the procedure above but choose "Delete RDS". 

When you create a room template, RDS is automatically linked to the room. 

7.5. Open RDS window for editing or reading 

From the room templates list (Project -> Room templates): 

 Double-click the room template 
 Or right-click and select RDS 

From the room list (Project -> Rooms): 

 Double-click the room. 
 Or right-click and select RDS 
 Or go to the menu and click Room -> RDS. 
 Or choose RDS from the toolbar. 

03.07.010 
Laboratory 

RDS: Unique 

Temp. max: 25 c 

Description: Work space for one 

person  

Temp. mim: 19 c 

Min.door opening: Wheelchair 

Occupancy: 2 persons 

Daylight: Outer wall 

Wireless network: No 

Single outlets: 3 

500 lux for workstation 
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Tip: The menu for both room templates and room has an additional option to Open 
RDS which is called Open RDS in new window. Normally, when you already have an RDS 
window open and choose to open RDS for another room, this will open in the window 
you already have on screen. If you prefer to have two windows open at the same time 
(for e.g. to compare RDS for two rooms), you should select Open RDS in new window. 

7.6. The RDS screen 

 

Figure 16: Example of the appearance of an RDS screen. The form may vary from project to project.  

The toolbar has the following options: 

 The Next and Previous buttons provide you with RDS information for the next and 
previous room for which RDS is created in the level you have currently selected in the 
room list (ref. chapter 3.3 for more information on navigating using Next/Previous). You 
can also use the drop-down menu /by clicking on the small arrow beside the button) to 
jump directly to rooms further forward or backward in the list. 

 The Save button saves RDS changes to the database.  
 The Copy from button allows you to copy RDS information from another room into the 

room you are working with. Possibilities will alter depending on the RDS status of the 
room (unique/from room template). 
 Copy from: Copies all RDS values from another room. They will be unique values in 

the room you are copying to. 
 Copy parts of RDS from: as above but this option gives you possibility to only copy 

specific tabs or data fields to the room. 
 Copy to: Copies all RDS values from the room you are working on to another room. 
 Copy parts of RDS to: As above, but this option allows you to only copy specific tabs 

or data fields to another room. 
 Copy status and values from room: In this option you can select another room and 

copy both RDS status and values to the room you are working with. 
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 The Print button generates a report of RDS information for the selected room. 
 Equipment in room: Opens the equipment list for this room. 
 View. Allows you to choose between different views. This limits the fields and tabs you can 

see on screen. The different views are defined by the project administrator.  
 The RDS log button displays changes made to the room. If the project has initiated 

logging of RDS changes, all changes will be stored and users can view the changes in the 
RDS log. 

 Note: Displays and allows editing of a comment/note to this RDS form. 
 Date: This field is available if there is a log for this room. You will then be able to view RDS 

for a specific date. It is not possible to choose dates which come before or after the log 
input was made. After you have chosen the date, fields which have been changed since 
that date will be marked with a blue asterisk. You can hold the mouse over the field to 
view the current value. 

 

NOTE: The difference between the Copy from and Copy status and values from room. 
Copy from will not do anything with the RDS status in the room. I.e. if you are working in 
room with unique RDS and select Copy from a room with RDS from template, like, the 
room will still be unique but all RDS values will be identical as the room you copied 
from. If you select Copy status and values from room and select the same room the 
RDS status will change so it will be identical as the room you copied from, and all values 
be equal. 

The status field shows you when an RDS link was created for the room, and when RDS data for 
the room was last amended. It also shows the rooms' RDS link. 

For derived rooms, fields which deviate from the template are marked with a red * (asterisk). 
The tabs where derivations occur will also be marked with a red *. You can hold the mouse 
over the field to view the original value. 

In rooms with derived RDS you will also be able to see a summary of all derived values by 
selecting  

 

Figure 17: Derived values 

This option will open a window that will show all derived values and set them back to template 
values. 
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Figure 18: Derived values 

To set values back to template values, select the fields using the tick box on the left side and 

menu. 

Pictures/Documents 

The RDS screen has a separate tab for pictures and documents. You can use this tab to add 
illustrations and other pictures in addition to documents you want to link to the room. For 
more information, see chapter 16. Rooms with RDS templates and derived RDS will also 
receive pictures and documents from the room templates.  

Equipment 

If you have equipment rights, you will see an extra tab in the window displaying the equipment 
added in the equipment list for the room - if this has been activated for the project. 

7.7. Groups 

The disadvantage (and advantage) with room templates is that they apply for all RDS fields to 
be set for a room. In a project, it is not uncommon to have several room templates for the 
different offices required, group rooms etc. For certain disciplines or fields in the RDS form, 
this may represent an unnecessary division and requirements may only be needed for certain 
fields, but which should also apply for numerous rooms within the project. The number of 
rooms which should naturally have the same requirements (belong to the same group) may 
also vary according to the relevant fields. 
 
In order to solve this issue, you can make use of requirement groups (or groups). 
Conceptually, this works in the same way as for room templates, but only applies to some of 
the fields in the RDS. Requirement groups are grouped from one group type. 
 

Group types 

Group types allow the user to organize groups. The group type defines the fields for which the 
group is to provide information. If, for example, you have a "Room temperature" group type for 
which you want to provide information on temperature requirements, you define that the RDS 
field maximum and minimum temperature are the fields on which the group type is to provide 
information. You can then assign the actual values for the groups in this group type. Other 
group types can apply for other fields. However, a field can only be assigned requirements 
from one group type, so for example, maximum temperature can only be assigned to groups 
in the "Room temperature" group type. 
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Figure 19: Example of Group types and Groups 

Rooms linked to a group 

A group can, as for room templates, be linked to many rooms. In the example below, you can 
see that three rooms have the same temperature requirements from the same group. If you 
update the value for the group, then this is updated for all the rooms. It is not possible to 
overwrite the requirements which come from a group for an individual room. If you require 
unique values for one room, you will have to remove the link to the group.  
 

 

Figure 20: Link rooms to a group 

 
 
However, as opposed to room templates, a room can also be linked to several groups which 
are organized under different group types. This is because we know that two groups in two 
different group types cannot have requirements within the same fields. The example below 
shows a room which has unique RDS, but requirements from two groups. These colored fields 
are from the group and can only be changed within the group, while the white fields are 
unique to the room. 
 
 

Group type: Define 
which fields in the 
RDS form on 

which groups 
shall make 
requirements 

Group: 
Linked to room and 

contains the actual 
requirements (values) 
  

Climate 

Work 
areas 

Group 
rooms 

Corridors Etc. 

Acoustics 

Offices Computer 
rooms 

Toilets Etc. 

Climate group, 
Work areas 

Temp. max: 25 c 

Temp. mim: 19 c 

01.03.050 
Office 

01.02.003 
Meeting room 

01.03.004 
Laboratory 
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Figure 21: A room can be linked to two or more groups in different group types 

 

7.8. Use of room templates and groups 

Requirement groups and room templates have slightly different applications and it is often 
advantageous to use these simultaneously. A room template can also be linked to a group. 
This means that all the rooms linked to the room template are also linked to this group. As the 
room template shall apply for all requirements in RDS, a room which has RDS from a room 
template cannot be linked to other requirement groups than those to which the room 
template is linked. The figure below shows an example of a room which has RDS from a room 
template. In turn, the room template has parts of its requirements from the group and these 
are transferred to the room. 

Temp. max: 25 c 

500 lux for workstation 

 

Temp. min: 19 c 

Facilities for use of PC 

Sound insulation: Personal, sensitive information 

Reverberation time: X sec 

Card reader/access card: Yes 

Maximum no. persons: 5 for short 
meetings 

Climate group, 
Work areas 

Acoustic group, 
Offices 

01.02.003 
Office, management 
RDS:Unique 
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Figure 22: Use of both room templates and requirement groups 

are connected to 
groups. Open Room overviewGroups and select a group within a group type. Press the 

Roo  to see what templates are connected to groups.  

7.9. Rules for / restrictions on the use of groups 

The following rules therefore apply for the use of requirement groups, with or without room 
templates.  

 If a group is to be directly linked to a room, the room needs a unique RDS. 
 If a room has derived RDS, you will only be able to overwrite the data which does not 

originate from the groups, but from the room template (purple in the figure above). 
 Individual rooms (or room templates) can only be linked to one group in a group type 

(cannot be linked to climate groups 1 and 2). 
 The requirements from one group cannot be overwritten either for room or room 

template. 

7.10. Use of groups in dRofus 

Group types and groups are created under the tab "Groups" which you will find beside the 
"Functions" tab in the room list. To create a new group type, right-click on "Groups" and select 
"New group type". You will now be able to assign a name to the new group type, for example 
"Climate zone". On the right of the screen, you will see two tabs. One is called "Room" and the 
other "Group type". Under the Room tab, you will see a list of the rooms which are linked to 
this group type. Under "Group type", you can add descriptions of the group type in the text 
field for "Description" and you can define the requirements to apply for this group type. When 
you click on "Change fields", you will see a dialogue box which allows you to choose the RDS 
fields to be included. You can choose to include entire tabs or individual fields by either 
double-clicking on the tab/fields or using the arrow in the middle of the dialogue box. Fields 
which have been included will be listed on the right-hand side. Once you have selected all 
relevant fields, you save your changes by clicking on the "Save" button. You have now defined 
the requirement fields to be included in this group type. 

Climate 
group, 
Work areas 

Acoustic 
group, 
Offices 

Temp. max: 25 c 

Temp. min: 19 c 

Temp. max: 25 c 

Temp. min: 19 c 

500 lux for workstation 

 Facilities for use of PC 

Sound insulation: Personal, sensitive.. 

Reverberation time: X sec 

Sound insulation: Personal, sensitive 

Reverberation time: X sec 

01.02.003 
Office, management 
RDS:From RT.001 

RT.001 

Office,  
1 person 
(Room  
Template) 

Card reader/access card: Yes 

Maximum no. persons: 5 for short 
meetings 

Permanent workstation: Yes 

Description, this is  where 
meetings 
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To create a new group, you right-click on the group type and select "New group", then give the 
new group a name. In the example below, two groups have been created under the group type 
"Climate zone" and named "Offices" and "Meeting rooms". On the right-hand side of the 
group window, there are two tabs; "Room" and "RDS". The room tab lists the rooms which are 
linked to this group. This tab also provides a number of options: 

 Add room: Allows you to choose rooms which you want to link to the group. Ref. chapter 
7.9 for rules/restrictions when using groups. 

 Open: Allows you either to open RDS room core, equipment in room or finishes for the 
selected room. 

 Print: Prints out all rooms linked to the group in Excel, Word or PDF format. 
 Search: Allows you to perform searches in the room list. For more information on the use 

of the search function, ref. chapter 4.3. 

Under the "RDS" tab, you will see the RDS fields you have selected for the group type in 
question. This is where you enter the actual values in the RDS fields. 

 

Figure 23: Example of a group type window 

 

Figure 24: Example of group window 

Link groups to rooms 

As previously mentioned, you can link rooms to a group directly from the "Room" tab under 
the group in question. Another way of performing this link is to go to the Rooms window and 

Group type 

RDS fields included 

Group 

RDS values from 
group 
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select the rooms you want to link to a group. In the room core, you can see the different group 
types which have been defined. The actual groups will be listed as options in the drop-down 
menu for each group type. You can also link rooms to a group by selecting one or more rooms 
and right-clicking and selecting "Add to group". 

 

Figure 25: RDS form with temperature requirements from a group 

Once you have opened an RDS with requirements from a group, these fields will be marked in 
yellow. You cannot make changes to these fields uniquely for one room. If you want to make 
changes to these fields, you have to change/add values under the Group tab in the Rooms 
window.  

Link room templates to groups 

To link a room template to a group, go to the room templates window; Project->Room 
templates. The group types are listed in the core information for the room templates. Select a 
room template and choose a group from the drop-down menu beside the group type. If you 
want to link a room template to a group, the fields within the group have to be free of 
information in the room template. You therefore have to delete the information in the fields in 
the room template before performing the link. 

 

Values from group 
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8. FUNCTION PROGRAM 

8.1. Introduction 

As with rooms, technical requirements for functions (departments and sections) can be 
described. As opposed to RDS, users can choose the information to be described and it is not 
necessary in principle to work your way through the entire form. The purpose of the function 
program is to provide a principal description or to describe requirements which apply for all 
rooms under a function. This is particularly beneficial during the early stages when, for 
example, the room list has not yet been completed and before you start on the RDS work, but 
can be used for all types of information and during all phases of the project. The type of 
information to be registered can be determined individually for different projects, as with the 
RDS form.  

8.2. Overview 

The function program is available from the "Function program" tab beside the room list in the 
Rooms window. 

New functions in version 0.8.8 include: 

 How the data is displayed and how to navigate 
 The option to add notes and pictures for individual fields 
 The different fields/titles are now organized in a tree structure which you use for 

navigation. This tree is made up of the fields which are actually used under the selected 
level in the room structure (i.e. as a type of table of contents). 

 When you view data from several fields at a time, the size also adjusts so that the field 
has the same number of lines as the text, but with a maximum limit. If one field has a lot 
of data, you will have to scroll. 

 Improved access to reports 
 A number of error recoveries (e.g. improved function for the mouse wheel). 

8.3. Change data 

In order to work with data in the function program, you have to navigate to the field you want 
to change by using the tree. If the field is a text field, you will then have all the space available 
to edit data. You can also use the toolbar, and click on "Show/Hide note" and "Show/Hide 
pictures" in order to change or add notes or pictures. Any fields which have notes or pictures 
will then be specified as such in the tree. 

If you want to add new fields, you can use the "Add ..." button on the toolbar or right-click on 
the overview where you want to add data and click on "Add". This provides access to the fields 
under the title you clicked on. If there are no fields available, this option will not be shown. 

s directly 
in to the text fields in the function program; 
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Images can also be copied and pasted directly into the text field. 

You can delete data on a field either by clicking on the red cross when you see numerous 
fields, or choosing "Delete" from the toolbar when you are in a specific field or right-clicking a 
field in the tree. 

 

Figure 26: Interface in the function program (N.B.Norwegian text) 

8.4. View and change data for several fields at a time 

Instead of just viewing and working with one field at a time, you can right-click a level and 
choose "Show all data under this level" (the same as double-clicking). You can also view all 
data by selecting "Show all data". As before, you will see an overview of several fields at a time, 
but in a more compressed view as text fields expand and shrink according to the volume of 
data in the field. If you want to view/change pictures or notes, you have to select a specific 
field. 

8.5. Navigation 

You can make use of short-cut keys to navigate. Use ALT+RIGHT ARROW and ALT+LEFT 
ARROW to move focus between room level, field tree and data field. You can also use the pop-
up menu button on the keyboard to open the right-click menu in order to add and delete fields 
etc. If you do not have a pop-up key on your keyboard, you can press SHIFT+F10. 
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Once you have opted to go down to a field, the system will "remember" your choice if you then 
navigate to a new room level. If, for example, you are in Function requirement, general and 
decide to navigate to a new level, you will see data under the Function requirement, general 
for the new level also (if this level has such data). Correspondingly, if you have opted to view all 
data under the electric power chapter via "Show all data under this level", and then navigate to 
a new level, you will see data regarding electric power for this level also. The field that the 
system "remembers" is marked in bold in the tree. 

8.6. Views 

The function program also has a number of options for viewing. 

 If you click on "Switch view" in the toolbar, you can decide whether the navigation tree 
shall be displayed above or to the left of the data. 

 "Expand tree" can also be turned on and off using the toolbar, if you would prefer the 
navigation tree to show all fields utilized under a certain level. 

Examples: 

 

Figure 27: View with expanded navigation tree on the left-hand side 
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Figure 28: View without expanded navigation tree at top 

8.7. Reports 

The toolbar also has an option which allows you to generate reports directly from the toolbar. 
Two formats are recommended for reports: PDF is the recommended format whereas RTF is 
more experimental but can be opened in Word: 

 Building program: Generates a report which has been set up according to the preferences 
of the Directorate of Public Construction and Property (Statsbygg), where data is 
grouped according to the fields in the database (per discipline). 

 Simplified building program: As above, but only with function requirements, room list and 
chapter 1. 

 Function program: Generates data per room level. In other words, all data entered for the 
project, and all data under the different sub-levels (not per discipline). 

There is also the option to export to MS-Word and MS-Excel. This only extracts the data which 
is currently displayed in the data window. 
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9. GRAPHICAL FUNCTION PLANNER 

9.1. Background 

The graphical function planner is a diagram editor used to visually plan functions and 
rooms in a project. You can use this to create, edit and delete functions and rooms, 
define programmed areas and the requirements between these. Diagrams are created 
as images which can be displayed in other parts of the dRofus program and included in 
reports. 

9.2. Concepts 

The editor utilizes the same functions and rooms as the rest of dRofus. As a result, each 
function and each room created in the editor will be shown in the room list and vice versa. The 
editor allows you to create requirements between functions and rooms. A requirement is a 
relation between two objects. There is a set of predefined requirements which you can use, 
such as "Nearness requirement: Same building", but you can also set up your own 
requirements. A requirement type has a specific style which defines the appearance of all 
requirements within that type. A requirement type can also be inverted, for example 
"Nearness requirement: Not same building", and the inverted requirement type has its own 
style. 

A diagram comprises a set of visual elements. It has a name, a description and a scale. The 
scale defines the relative size of the elements in the diagram. A diagram either belongs to a 
project or a function, and each of these may have zero or several diagrams. 

The editor utilizes the same access rights as the rest of dRofus. You need read access for 
rooms in order to start the editor. You need write access for rooms in order to set up new 
diagrams, functions, rooms and requirements. 
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9.3. User interface 

 

Figure 29: Screen shot of the function planner 

The image above shows a screen shot of the graphical function planner. The editor comprises 
a main window with three parts; a set of tabs on the left-hand side, a diagram view in the 
center and a Properties view on the right-hand side.  

9.4. Tabs on the left 

Function and Room view 

The first tab displays all the functions and rooms which have been created for the project. It 
displays the same functions and rooms as those displayed in the dRofus room list. When you 
double-click on a project or function, all the diagrams created for the object selected will be 
displayed. 

You can create a function by right-clicking either on a project or another function then 
clicking on "New <level>". You can delete a function by right-clicking on a level and clicking on 
"Delete <level>". You can create a room by right-clicking on a level and clicking on "Add room". 
You can delete a room by right-clicking on a room and clicking on "Delete room". Please note 
that you cannot create a level under another level if it has one or more rooms. Likewise, you 
cannot create a room under another level if it has one or more sub-functions. 

Viewing figure properties 

The editor has a large set of predefined figures under the second tab. You can add a figure by 
dragging it from the tab and dropping it into a diagram. You can change the size of a figure by 
clicking and dragging the toggles. When you select a figure in a diagram, its properties are 
shown in the property view on the right. A text figure is just a square figure so the same 
applies to this. 

Viewing requirement definitions 
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The last tab displays the properties of a requirement type. Here you can create, edit and 
delete requirement types. You can change the normal and inverted style for a requirement 
type and define whether a requirement type can be inverted. You can only define that a 
requirement type cannot be inverted if no requirements are utilizing the inverted version of 
the requirement type. 

9.5. Diagram view 

The diagram view displays all the diagrams for a project or a function. You add functions and 
rooms to a diagram by clicking and dragging them from the room and function view on the 
left. If a function or a room has already been added to a diagram, neither its principal 
functions nor sub-functions can be added to the same diagram. By way of example, function 
A has a sub-function B which in turn has a room R. If A has been added to a diagram, neither B 
nor R can be added to the same diagram. If R has been added to a diagram, neither A nor B 
can be added to the same diagram. 

The editor has four modes; select, function, room and text figure. You can switch between 
these four by clicking on one of the four buttons on the toolbar, illustrated below. In the Select 
mode, you cannot draw elements in a diagram but one or more elements can be selected, 
moved and resized. In the Function mode, a function is created if you draw a square in the 
diagram. In the Room mode, a room is created and in the Text figure mode, a text figure 
created if you draw a square in the diagram. 

 

 

Figure 30: Mode buttons 

Draw a line from a function or room to another function or room to set up a requirement 
between them. You can create requirements in all modes with the exception of Select. 

9.6. Properties view 

When you select a function in the function and room view or in a diagram, its properties will be 
displayed in the properties view as described in the figure below. If you click on the colored 
button under the function name, a dialogue box will open where you can choose a color for 
the function. This color is used as the background color for all figures for the function in all 
diagrams in order to provide a consistent look. 
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Figure 31: Level properties 

Function planner areas 

Planned areas are used in the early phase of a project to plan the area of a 
function/department. These values are independent of the values of other functions and are 
not summarized in any way. 

Planned gross indicates the planned gross area of the function. Planned net specifies the 
planned net area of the function. Planned gross / net factor indicates the value of the planned 
gross floor area divided by the planned net area. You can specify the planned gross area and 
have calculated the planned gross / net factor, or set factor and have calculated the planned 
gross area. Click on the padlock icon to lock or unlock values. A locked value is automatically 
calculated based on the two other values 

Sum areas 

Summed areas are calculated based on the values of any sub-functions and rooms. 

Summed net area specifies the summed net area of the function. If the function has one or 
more sub-functions, the summed net specifies the sum of the net areas of all the sub-
functions. If the function has one or more rooms, the summed net area specifies the sum of 
the programmed area of all the rooms. If the function does not have rooms or sub-functions, 
the summed net area specifies the total of programmed net area. 

Summed gross area is sum net multiplied by the gross / net factor. If you change the 
aggregated gross / net factor and the function has sub functions it will also change the 
summed gross / net factor corresponding to all the functions. 

Figure size 

The size of a function figure in a diagram depends on the function summed net area. This can 
only be changed if the function does have neither rooms nor functions. If so, you can either 
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enter a number programmed net or dragging the handles to the function figure in the 
diagram. 

The 'Lock  button controls whether you can change the shape of the function in 
the diagram without changing its summed net area or not. Once the area is locked, you can 
only change either the height or width of the function figure. 

The list at the bottom of the property view displays all of the requirements between the 
function and another function or room. By right-clicking on a requirement in which you can 
add to the requirement in the current diagram, remove it from the current diagram or delete 
it. A requirement will s and can still be added again in the same or 
another diagram. 

9.7. Viewing room properties 

When you select a room in the function and room view or in a diagram, its properties will be 
displayed in the properties view as shown in the figure below. The background color for the 
room originates from the function to which it belongs. 

 

Figure 32: Room properties 

The "Programmed" and "Designed" text fields show the room's programmed area and 
designed area respectively. You can change the size of the room either by dragging the 
toggles around the room figure in a diagram or typing a number in the "Programmed" text 
field. The "Lock shape area" button controls whether you can change the room's shape in the 
diagram without changing its net area. Once this is locked, you will only be able to change the 
height or width of the room's shape. 

The list at the bottom of the Properties view shows all the requirements between the room 
and a function or another room. When you right-click on a requirement in the list, you can add 
the requirement to the prevailing diagram, remove it from the prevailing diagram or delete it. 
When a requirement is deleted from a diagram, it will still exist and can be re-added to the 
same or a different diagram. 

9.8. Viewing requirement properties 

When you select a requirement in a diagram, its properties will be displayed in the properties 
view. This shows all the objects to which the requirement belongs, for example two functions, 
and you can change the requirement type. You can only choose one requirement with the 
same requirement type as the prevailing requirement. 
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Figure 33: Requirement properties 
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PART 3: ITEMS 
MODULE FOR ITEM PLANNING 
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10. ITEMS 

10.1. Introduction and definitions 

An Item is an equipment unit with such a detailed level of description that its functional 
requirements and utilization are determined, but where the description does not indicate a 
specific type or supplier. An Item is specified and can be used later for several rooms and 
other projects. Items are listed in an Item register which is often shared among several 
projects.  

Items are positions within a function structure, just as with rooms, ref. 4.1. The function 
structure normally has two levels, but may have more. The structure shall group Items 
functionally so that they are easy to find. The position within the function structure also forms 
the foundations for the Item number assigned to Items when created. This also follows the 
same pattern as when rooms are assigned room function numbers, ref. 4.1.  However, there is 
a significant difference between numbering of Items and of rooms. While the room function 
number follows the room throughout the entire project, Item numbers may be changed and 
the number can also be re-used. This is because an Item can be moved to other groups once 
they have been created, implying a need to change the number. Items can also be deleted.  

There is a certain amount of basic information for Items. This includes budget price, which 
subsequently forms the basis for cost estimates, date for when price was obtained or 
stipulated and a price comment for where the price was obtained, and name to describe the 
Item. Each Items can also be linked to a responsibility group which describes the consultancy 
group with responsibility for planning the Item, and a tender group which groups Items to be 
purchased simultaneously.  

Moreover, Items has a specification which specifies the  functionally.  

10.2. Item overview 

The Item overview contains an overview of the entire Item register. You can open the overview 
from the Project -> Item Overview menu or from Item in the start window. An example of an 
Item overview is illustrated in the image below. You can navigate in the Item structure on the 
left-hand side in the same way as in the room structure. If you place your cursor on a main 
level, the list on the right will show all the Items available in its sub-levels. Therefore, the list on 
the right shows the Item available under the level selected, with certain information. Below 
this is an overview of the rooms in which the Item selected exists (or the first Item if no 
special Item has been selected). Under this are any sub Items to the item. This is described in 
more detail in 0 and 10.3 respectively.   

Tip: These two extra windows can be activated and deactivated by clicking on 
Occurrences or Sub Item on the toolbar. If these windows are deactivated, you have 
more space for the Item database. Moreover, it is quicker to navigate as the program 
no longer has to find this information.   

Tip: You can open equipment lists and sub Item windows and print out lists and open 
Item by right-clicking on an Item in the Occurrences or the Sub Item window. 
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Figure 34: Item overview 

The status bar shows you how many Items are available in the selected level, how many 
occurrences (or more specifically, how many rooms the Item is found in) and how many sub 
Items the Item has.   

The Items in the overview is represented by the following icons: 

Icon Definition 

 

A comment/note has been registered for this Item 

 

An picture exists for this Item 

 

You can perform searches in the Item overview by using the search field at the top right. Type 
in your search word and press Enter. This will open a list of all the Items where the Item name 
or Item number contains the word you have typed in. 

You can also carry out a more advanced search of all available fields in the Item by clicking on 
the Search" button. Ref. information on searching for rooms in paragraph 4.4. Searches can 
be saved and remain available when you click on the drop-down arrow by the Search button.   

A print-out of the Item overview provides you with an Item list for the level you have selected, 
or the entire list if you are at project level. For other reports, go to Project  
->Reports. 

The Show IFC Data button shows the Item overview in IFC mode, with the option to view the 
Item and occurrences drawn and those which are lacking on the drawing. This is described in 
a separate users' guide on IFC, available at 
http://drofus.no/assets/files/Documents/user%20documentation/IFC%20support-en.pdf 
 
You can also change one or more Occurrences by selecting them and clicking on Change. Ref. 
11.3 for more information. 

http://drofus.no/assets/files/Documents/user%20documentation/IFC%20support-en.pdf
http://drofus.no/assets/files/Documents/user%20documentation/IFC%20support-en.pdf
http://drofus.no/assets/files/Documents/user%20documentation/IFC%20support-en.pdf
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TIP: You can change the columns to be displayed in the lists by right-clicking in the list 
and clicking on Add/Remove columns. 

Changes to function structure  

The function structure can be changed by right-clicking in the level required. This allows you 
to delete the level (as long as it has no Items), add a new sub-level or change the name and 
number of the level. Please note that if you change the number of a level which has Items, all 
the Item will also have a new number.   

Change, move and add Item 

You create an Item by clicking on New Item on the toolbar or opening the Item menu from the 
main menu bar, or the menu which is available when you right-click the Item list. This creates 
an Item in the current level, which is then assigned an Item number. You will then see an Item 
window where you fill in the information on the Item. You can change this information at a 
later date by double-clicking on the Item or clicking on Open Item from the menu. You can 
also move an Item from one level (group) to another. Click on the Item and drag it over to the 
group you want to move it to then drop (Drag'n Drop). Please note that this will result in a new 
number for the Item.  

Item window 

The screen where you can change basic information and specifications for an Item may look 
like figure 30. 

 

Figure 35: The screen may vary from project to project. 

Basic information for the Item is shown at the top with the specification below. The toolbar 
has the following options: 

 You can navigate to the previous/next Item in the list. 
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 The Items log provides an overview of changes to the Items. 
 The Copy from/to function copies the specification only for the Item from another Item to 

the current one, or from the current Item to other Item. For a more detailed procedure for 
the above, ref. copying RDS information, paragraph 7.6. Please note that all existing 
specification information will be deleted in the Item to which you copy.  

 The Print button generates a specification report for the Item. 
 The Note button displays comments related to the Item.  

10.3. Pictures and documents for Items 

It is possible to link one or more pictures to an Item. This can be utilized to illustrate for an 
architect the appearance of Item. To view or add pictures linked to Item, click on the last tab in 
the Item specification, entitled "Picture/Documents". You can also add documents/files under 
this tab. Ref. chapter 16 for more information on the use of pictures and documents. 

10.4. Sub Items 

Item may comprise other Items if you add sub Items. This is to allow users to build up a main 
Item of several other independent Items so that you can specify and use the parts, and merge 
several Items which are to be defined as and make up one unit. When you later place the main 
Item in a room, all the sub Items will automatically follow.  

When you add sub Item to a main Item, you have the option whether to calculate quantity for 
sub Item or not. If you choose to calculate quantity for the sub Item, it will be calculated as a 
net occurrence in the room. Consequently, the price of the sub Item will be included in the 
cost calculation for the room, in addition to the price for the main Item. In most cases, it is 
appropriate to stipulate the price for the main Item as zero. However, if you choose not to 
calculate quantity for the sub Item, the Item will not have any occurrences and will only be 
gross, which in turn implies that its cost will not be included in the calculation. This is to allow 
pricing of the main Item without having to price sub Item in detail. It will also imply that the 
main Item is procured as a unit, and not in parts as the parts do not have any net occurrences. 
If you prefer to procure and price the parts, you have to choose the option to calculate 
quantity. You can also choose to calculate quantity for some of the sub Item only and not all. 

If you want to change, add and delete sub Item, you select the sub Item from the toolbar 
Figure 31 provides an example of such a window. 
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Figure 36: Sub Items 

When you change, delete or add any of the sub Item, the relevant lines are marked in red and 
the status bar shows the changes made. 

The following functionality is available either from the toolbar or the menu. The options 
available vary according to whether you have selected a specific Item or not: 

 The Add  button adds sub Item to the list. This option allow you to add several Items from 
the Item overview in one action. You can find these either by scrolling through the Item 
structure or by searching by Item name or number. On the right-hand side of the screen 
is a list with the Items you want to add to the list. To move an Item from the left to the 
right, double-click on it or select it and click on the > button. If you want to delete Item 
from this list, click on < or double-click on the Item you want to remove. The << button 
removes all the selected Item. Once you have selected all the Item you want to add, click 
on OK. 

 Double-click an Item to change the quantity and choose whether you want calculation of 
quantity for the Item or not.  

 Click on Open Item to open the Item window for the Item selected. 
 Click on Delete to delete Items from the list. 
 Click on Copy to copy the list with sub Item to one or more other Item.  
 Click on Copy from to copy the list with sub Item from another Item to the current one. 
 Click on Print to print out the list of sub Item. 
 

Swapping sub Item  in room 

When using the Parent/Child concept to plan Item sub-Item inside the rooms. 
This will ensure that wherever you are using a main Item, its sub or one of its child items will 
also be included. This adds a great flexibility that also greatly reduces the need to create many 
variants of packages. Sub-Items can only be swapped if the sub has a parent, child og sibling 
Item possible in derived and unique equipment lists. 

lem: They have a lot of medical equipment and to ensure that 
they were planning and designing the correct number of power outlets, they added a general 
power outlet (GPO), as a sub Item to every Item that needed one. Now, depending on where in 
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the building the equipment are placed, the equipment would need a different type of outlet, 
e.g. in an emergency department they would use an emergency power outlet. 

To resolve this problem the project can create three child items of the GPO.  This will let them 
choose in the room what kind of outlet that is required, and at the same time ensure that an 
outlet is always included when adding the medical equipment to the room. The subs can be 
swapped in both unique and derived equipment lists, but not in an equipment list coming 

identical to the template. 

 

Figur 37: Swapping subs in room 

Swapping sub Item by right click on 
the sub Item and select Item Item overview. 

10.5. Parent / Child Item s 

Inheritance of specification 

Type data on Item allows you to have consistent data for all your occurrences in room 
(instances). Using a dynamic GUI it is not uncommon to have several dozen requirement 
parameters for an Item. If you have many different types/variances of an Item and would like 
to share requirements you can use the parent/child relationship. 

You can create a new child Item from any Item by selecting it in the Item overview and 
selecting  Item . The new child Item will share the first part of the Item number with 

ce, but this 
information is not dependent on the parent and can/must be set unique for each child. 

The dynamic GUI specification follows the parent so any data you set on the parent will show 
on the child unless you overwrite / specify on the child (like derived RDS). You can use this for 
infinite depth.  

For example if you have an office chair with different variants, you can create one parent Item 
and specify a description and other g data. You can then create children for the different 
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variants you are using in the project. Any later updates to description will be updated for all 
the children, unless this value is overwritten on the child. 

 

The specification is then inherited down so you can add general descriptions and or even the 
dimensions on the chair, general. You can then give different widths for the children and for 
the grand child you can overwrite some additional data from that of either the parent or 
grandparent thus creating a mobile version. When looking at the Item overview you will see 
the inherited values as normal values and the unique values for the child will be marked by a 
red star. If you hover your mouse over any of the inherited values you will see from what 
parent Item the value is from (parent, grandparent, great grandparent etc). 

 

Ifat any stage you would like to remove a unique value for a child Item and instead let the 
value be inherited you can click on the 
overwritten value you would like to clear and press delete. 

Many to many link with model 

When using parent and child Items this can also be used to support many to many 
relationships between dRofus and the model (Revit/ArchiCAD): 

 Many-to-one relationship with model if you would like to have a higher level of type detail 
in dRofus than in the model.  E.g. if you in dRofus have different versions of a laboratory 
bench that is important for the user and costs and see in reports, but the geometry is the 
same so you would only like to use a generic object in the model. You can link the parent 
Item to the model and any Item in rooms checks will report no errors if the count of the 
parent match. 

  One-to-many relationship with model (Revit/ArchiCAD) if you would like to have a higher 
level of type detail in the model than in dRofus. E.g. if you have different colors on an 
object (as type information), but for checks with dRofus you only would like to compare 
count and make sure it is in the correct rooms  you create the different variants as child 
Item in dRofus and link them to the model, but in dRofus you place the generic parent 
object in rooms. 

See the user manual for the different add-ons and on how to do this with the add-on. 

Connect already created Items to a parent as a child Item 

You can create child of already created Items in the Item overview. If you e.g. have an Item 
that you rather want as a child to another Item you can right click on one or several selected 
Items  

Inherited 
values 

Unique 
values 
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In addition, the childs will 
inherit values from the parent where values is not overwritten by the childs. 

Swap Parent Item with Child Item in equipment lists 

When using a parent Item in equipment list you can easily swap between the parent used to 
ny other Item

list in the Item overview. You will only be allowed to swap Item
equipment lists. 

To swap a Item Swap Item Item have child Item
be displayed in the menu for easy access. If you want to swap with another Item select 

Item Item Item  

 

Figur 38: Swap Item in equipment in room 

10.6. Item and Equipment list user rights by responsibility group 

Each Items in dRofus can be assigned a, project defined, responsibility group (e.g. ARC, IT, INT 
etc). In the web administration site administrators can then set different levels of access 
rights, from full write access on the Item too not see at all, for each responsibility group. This 
means that you can set very specific user access levels for each user.  

Users can have different access rights to Item depending on what responsibility group they 
are assigned, both in the Item overview and in the equipment list in the room. This is shown 
visually by greying out the one the user cannot edit: 
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These user rights are not only enforced when working in the dRofus client, but also when 
using any of the add-ins, admin operations (import/export), reports and even direct SQL 
access. 

Please look in the administration guide for how to set the different access rights. 
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11. EQUIPMENT IN ROOM 

11.1. Introduction and definitions 

Equipment lists can be linked to rooms and room templates, i.e. lists of the Item to be 
included in a room. When an Item is entered for a room, we say that the Item is an occurrence 
in the room. Such occurrences are linked to information.  

 Quantity - how many of the Items are to be included in the room. 
 Existing quantity - If any of the equipment already exists so that procurement is not 

necessary, this can be specified here. This quantity will then be deducted from the net 
accounts for this Item. 

 Priority - Priority for how important the equipment is. 
 Owner - If one or more parties own the equipment, the party to be specified as owner of 

the equipment can be defined here. 
 Occurrence data - Project defined properties/specification. See section below. 

The quantity of each Item forms the basis for the gross quantity of this Item in the room. The 
net quantity is the quantity minus the existing quantity. In addition, there are sub Item which 
are not to be included in the quantity calculation and deducted so that they are not part of the 
net quantity. Net quantity together with the Item budget price provides an estimate of how 
much an equipment list for a room will cost. This total figure will be presented in budget 
reports and reports on equipment in room.  

Equipment lists from templates 

When you create a room template, an empty equipment list will also be generated. This can 
then be used to create an equipment list template which can be subsequently linked to a 
room.  

Equipment lists linked to room 

There are different methods of linking equipment lists to a room, depending on whether you 
intend to use a room template or not. You decide this when you create the equipment list for 
the room, see below. A room can therefore have the following status in terms of equipment 
list: 

Equipment list not created means that the room is not connected to an equipment list. 

Equipment list from room template means that the room has an equipment list from a 
room template. This implies that it is not possible to edit the equipment list directly in the 
room, but the equipment list must be edited in the room templates from which it originates. 
This means that when you change something in the template list, the equipment list will 
change for all rooms which have equipment lists from the room template.  

Equipment list derived from room template  

Derived from template means that the room has an equipment list from a room template, as 
above, but that it is possible to add new equipment, remove equipment and edit quantities 
and occurrence data to the Item  

Derived equipment list 
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Unique equipment list 

 If the equipment list for the room does not have any features in common with other rooms, 
such that it is not beneficial to create it from a template list, the room can have a unique 
equipment list. In such a case, you start with an empty list where all changes are permitted.  

11.2. Creating and deleting equipment lists to rooms 

You create and delete equipment lists for rooms from the room window (Project->Rooms) as 
follows.  

 Select the room for which you want to create an equipment list, or select several by 
holding down Ctrl or Shift. 

 Right-click and select "Equipment" then choose the link you need. 
 You can connect a room to a template RDS and template equipment lists in one 

ght click menu. Select 
what you want to be created from the template and select which room template to 
connect to. In the dialogue window you can also chose to copy room name and 
programmed area from the room template to the rooms you have selected. 

 If you want to delete equipment lists, follow the procedure above but choose "Delete 
equipment list". 

 

 

A room template is automatically linked to an empty equipment list when a room is created.  

11.3. Editing equipment lists 

To open an equipment list: From the room list (Project->Rooms or room template list 
(Project->Room templates). 

 Select the room you want. 
 Right-click on the room and click on "Equipment in room", using the toolbar button or 

CTRL+RETURN. 

An example of an equipment list is illustrated in figure 32. All the options in this window are 
available by right-clicking in the window or from the "Equipment in room" menu from the 
main menu bar. Some of the options are also available from the toolbar. You now have the 
following options (the majority of which are also available as short-cut keys): 

 Next and Previous buttons for navigation to next/previous equipment list. 
 Edit (open by double-clicking an Item) opens a dialogue box where you can edit quantity 

and existing quantity for this Item (Figure 33). 
 Click on Open Item to open the Item specification for the Item selected. 
 Click on Sub Item to show the list of sub Item for the Item selected. 
 Click on Existing equipment to show any existing equipment linked to this occurrence 

(ref. chapter 12). Select one of these to open the component in question.  
 Click on New Item to open a dialogue box where you can select Item which can be added 

to the list. This dialogue box allows you to add several Item from the Item database at 
one time. You can find these either by scrolling through the Item structure or by 
searching by Item name or number. On the right-hand side of the screen is a list with the 
Item you want to add to the list. To move an Item from the left to the right, double-click 
on the Item. If you want to delete Item from this list, double-click again on the Item you 
want to remove. Once you have selected all the Item you want to add, click on OK. 

 Click on Delete Item to delete the Item selected from the list. 
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Figure 39: Example of an equipment list 

 

Figure 40: Edit quantity, existing quantity, priority and owner for the occurrence. 

 
 Delete all deletes all Item in the equipment list.  
 Undo delete removes the selection for deletion for the Item. Please remember to do this 

before saving. If you save first, the delete function will be performed and you will not be 
able to undo. 

 Click Copy from/to to copy the equipment list from or to another room. If you choose 
Copy from, you will see a list of other rooms. Select the room you want and click OK. If you 
choose Copy to, you will be able to copy the equipment list to one or more other rooms. 
Select the rooms you want to copy to by clicking them over to the list on the right side. In 
both cases the room will get the exact same equipment list and equipment status as the 
room you are coping from/to.  

 The Equipment in room log option displays a log of changes to the equipment list. 
 The Print button gives you different report options to generate to Word, Excel or PDF.  
 Click RDS Item to check all defined rules for a room, see chapter 12.  
 The Show IFC Data button shows the Item overview in IFC mode, with the option to view 

the Item and occurrences drawn and those which are lacking on the drawing. This 
requires import of IFC data from the drawing program described in chapter 20.  
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Tip: You can also change a number of occurrences at one time by selecting several 
(with the SHIFT or CTRL keys and mouse). You have to choose the field you want to 
overwrite by flagging it in the check-box in front of the field and typing in the value you 
want. In the example below, the quantity for all selected occurrences will be 2. 

  

Icons and status in the equipment list 

If a note has been attached to the occurrence, this will be shown by a note icon (the same as 
that used in the room list, ref. 4.4). 

Other icons displayed refer to phase for the occurrence. For a definition of the individual 
symbols, ref. the users' guide for the procurement. You can also see the phase for the 
occurrence and the quantity in the status bar. This quantity is either stated as 
purchase/option or just a number. 

11.4. Move occurrences 

You can move occurrences from one room to another. By doing this you will keep all data on 
the occurrence when you move it. Right click on the occurrence you want to move and select 
Move occurrence . If you want to move several occurrences in the same action you can 

select more occurrences by pressing SHIFT or CTRL. 
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Figur 41: Move occurrences 

Note that you cannot move an occurrence that comes from a room template or equipment 
template. You can move occurrences to/from unique equipment lists or additional 
occurrences in derived equipment lists. 

11.5. Changes in derived equipment lists 

When you have a derived equipment list you can add, delete and change quantity and data on 
the occurrences. The changes occurrences will be colored orange to indicate deviations from 
the template values. When working with derived equipment lists you should be aware of these 
rules; 

 Adding equipment to the template will add to all derived lists as well. 

 Removing the occurrence from the template will remove it from all equipment lists, 
also in derived equipment lists. So deleting the two chairs in the template will delete 
the chair in this room too. 

 Derived occurrences will no longer be updated from the template. If you change the 
quantity in the room like in this example, updating the priority on the template will 
not change the priority for this occurrence. 
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Figur 42: Dervied equipment list 

11.6. Changes from Item overview  

The equipment list can also be changed from the Occurrences window in the Item overview. 
This can be practical if you want to change numerous occurrences of the same Item. You can 
also select several occurrences and change them at the same time. With the Item overview, 
you can also move all occurrences from one Item to another using the right-click menu. 

11.7. Occurrence data in room 

In addition to quantity, priority, owner and comment you can also create 
your own occurrence properties. This can be anything from numbers needed in the project to 
the color of a chair. 

Unlike the other properties, the occurrence data is always unique to the specific FFE item in a 
room and is not inherited from the template (the template cannot have occurrence data). 
This means that even though two rooms have the same equipment list from a room template 
they can have different values between the each individual occurrence in each room (e.g. 
color or number). 

There are numerous use cases where this can be utilized, but there is always a trade of 
between choosing to storing data on the occurrence vs. storing it on the Item (type). You can 
use occurrence data to allow for small variances that should not affect the room templates or 
in cases where there is a property more related to where
depending on floor level, but the quantity of each type should be the same. If you use 
occurrence data you cannot use templates to save you from updating each record. 

When changing multiple occurrences you can also update custom occurrence data, but note 
that it would only allow you to change properties that are available on all the occurrences. 

See admin guide for how to create new properties (dynamic GUI) and how to control on what 
Item the property is shown (Item view filter).  
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11.8. Multiple equipment list types 

The default behavior is to have one equipment list type is the 
recommended way if the same group of user are responsible for working with all the 
equipment in dRofus. This workflow allows to enforce that only one template can be assigned 
to a room, this is  

But if more than one group is working with equipment in dRofus and/or you would like to use 
templates that span different types of rooms and/or you would like to limit access rights to 
different Item lists using multiple equipment lists allows for this. One example might be that 
furniture and medical equipment could be placed in different lists so that they can utilize 
different templates and perhaps have different workflows for creating the content. 

Manage Equipment List Types 

You can modify what equipment lists to use as an administrator from within dRofus: 
Administration -> Settings -> Equipment -> Equipment Lists. 
When you create more than one equipment list type in the project they all work as 
independent lists for the room. If you e.g. create equipment list types Furniture and Medical 
Equipment, each room will have independent status for each list type. So room A can have a 
unique Furniture list, but have a Medical Equipment list from a room template. 

Room Templates and Equipment Templates 

A room template will always have all the equipment lists defined, but when you relate a room 
en let the room 

use different room templates for the different equipment list types. 

If you have enabled equipment list types (Administration -> Settings -> Room Templates -> 
Settings) you get one list of equipment templates per equipment list type and they can 
therefore only be used as templates for equipment lists of that type. 

Equipment List Types and Access Rights 

An equipment list type can be assigned to one or more responsibility groups. If a list type is 
limited to one or more responsibility groups this means: 

 Only Items with any of the responsibility groups set can be added to a room. This implies 
to all subs Items of the Item are added to the room as well. This will prevent an Item that 
has been placed in an equipment list from changing to an illegal responsibility group (or 
add violating sub-Item) later. 

 Only users with proper permissions to all the responsibility groups for the listcan do list 
operations on the room (e.g. create, delete and attach to template). 

 Users with read permissions to any of the responsibility groups will see the lists. In other 
 

a user which has equipment rights none (level 4) 
even exists in the database and not see status etc. 

 When adding new occurrences from model (Revit/ArchiCAD) they can automatically be 
placed in the correct equipment list if the responsibility group is correct set. See section 
below. 

If an equipment list type is not limited to one or more article responsibility groups this means: 

 List operations on the room are available for any user that has at least limited write 
access to any article group, but will fail if any equipment in the list is read only for the 
user. 
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 The list (and list status etc.) are visible to any user with any equipment rights *). 

Note: You should be careful with limiting all your equipment list types to responsibility 
groups. This is because you then potentially can have Item in your database that you 
cannot add to a room! E.g. Item without any responsibility set can only be added to 
equipment lists types not limited to any responsibility group. 

Even though an equipment list type is visible to a user does not necessarily mean she can see 
all Item occurrences in that list if she is limited to not see some responsibility groups in both 
cases. 

Reports 

When using multiple equipment lists the default report prints all the equipment lists after 
each other in the order you define in the settings for the equipment list type. The user can also 
limit it to print one or more equipment lists for each room. 

If you make your own custom report using XF designer the room has multiple <occurrence-
list> nodes with an attribute equipment_list_id. You can then decide if you would like to 
iterate over all occurrences or each list and then occurrences or only one specific equipment 
list type. 

Multiple Equipment Lists from Revit / ArchiCAD 

When working in Revit or ArchiCAD and comparing counts of Item Item Item in 
all equipment lists in dRofus are combined. You can use the options filter to 

limit what to see. 

When adding new occurrences from Revit/ ArchiCAD to dRofus it is automatically added to the 
 

 If the Item to add has a responsibility group: it will look first for anequipment list type that 
is limited to this responsibility group and add to it. 

 If none are  found or Item does not have a responsibility group  it will be added to first 
equipment list that is not limited to any responsibility group. 

For example if you have three equipment list types: Doors (limited to responsibility group D), 
Medical equipment (limited to responsibility group M) and Furniture (with no limitation). All 
doors and medical equipment will be added to Doors and Medical equipment lists, and the 
rest will be added as Furniture. 

Incompatibility with previous versions of dRofus (< 1.6) 

It is important to note that if your project uses more than one equipment list, users logging 
into dRofus with a client older than 1.6 will not be able to use the room and equipment 
module and will  
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12. EXISTING EQUIPMENT 

12.1. Introduction 

Existing or transferable equipment can be registered in a separate register in dRofus. The 
equipment can then be linked to planned equipment in room. Normally, you would first 
register all equipment which may be moved, then decide whether the equipment can be used. 
You can then form a link to an Item which this equipment is to replace, and then an 
occurrence of the Item in a room. 

12.2. Overview 

The register of existing equipment can be opened from the Project->Existing equipment 
menu.  This list includes the name of the device and its status (such as whether the device is 
worthless or could be used), any links to Item and room if registered and other central 
information.  

 

Figure 43: Existing equipment window 

The overview will initially be empty. You can then choose whether to register a new 
component by clicking on Add or searching for an existing component/device. The figure at 
the bottom right-hand corner of the window shows how many components there are in the 
database and how many which are now displayed in the list. You can choose to view all 
components by selecting Show all from the toolbar. Please note that this may take some time 
if a lot of devices have been registered. At any time, you can transfer the active list of devices 
to MS-Excel by pressing CTRL+E when in the list. When performing searches in the register, 
you can search for parts of the word in the device name, current department, registration 
number and status. 

TIP: Press F3 when in the list to go to the search field. The search you performed will be 
shown in the status bar at the bottom of the window. 
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12.3. Registration 

You can register information on individual components under the Details tab. You can add 
pictures of the component and any documents using the Pictures/Documents tab. Ref. 16 for 
a description. 

If you want to link a device to a room, you first have to specify the Item to which the 
equipment component corresponds. You can then link the device to a room where the Item 
occurs in the equipment list. Once you have done this, any data registered for the existing 
occurrences in the Item (ref. 11.1), will be removed and replaced by the quantity of actual 
devices linked to this occurrence. The total net quantity of this Item will therefore be reduced. 
The program does not prevent you from registering an excess amount of existing Item for an 
occurrence, so you have to take care that the net quantity is not negative. The equipment list 
will display information that existing equipment is linked.  

Once you have linked existing Item to an occurrence in a room, you can no longer delete this 
occurrence from the room without first removing the existing equipment. If the room has 
occurrences from a room template or template, you will not be able to change these until any 
existing Item have been removed from the rooms which utilize this list. Consequently, you 
cannot delete or redo the list until this has been done.  

12.4. Copying and registration of several equal components 

From the list, it is simple to copy one or more components to one or more copies. Select the 
components you want to copy then click on Copy in the right-click menu. This creates one 
copy of the selected components. If you want to create several copies, click on Make multiple 
copies and type in the number of copies you want. Please note that the copied components 
will have the same registration number (you will most likely want to change this) and the 
room links will not be copied. You have to do this individually for each component. 

12.5. Import from MS-Excel 

Ref. 19.9 
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13. CHECK FOR UNDER-SPECIFIED AND OVER-SPECIFIED 

13.1. Introduction 

When both rooms and Item have been specified in detail, the correlation between these 
specifications can be checked by defining a set of rules. When an Item is entered for a room 
and this is governed by constructional requirements, the rules set up can check whether the 
room data sheet for this room meets the requirements. Say that 3 computers are to be 
placed in a room and all require power supply. If only 2 sockets have been set up in the room, 
then there is a probable error. If 30 sockets are set up in the room, and no other equipment in 
the room requires power, this is also a probable error. This is an example of a resource in the 
room you want to include, but other rules are also possible; for example, certain types of 
equipment may require a minimum/maximum temperature in the room in order to function 
properly, or require noise insulation as the equipment generates a lot of noise.  

The set-up of rules can be complex and is normally carried out by the project administrator.  

13.2. Creating and deleting rules 

You can create rules which can check between all logical (Yes/No) and numerical (digits) 
fields in RDS and the Item specification. The type is automatically determined when you 
choose the fields between which you want to set up the rule. Table 1 illustrates the correlation 
between field type and the type of rules which can be created.  

RDS field: Item field: Can be 

counted 
down: 

Result: 

Logical Logical No Under-specified 

If the Item field is "Yes", the RDS field must also be "Yes". 

Example: If the Item is flagged for vacuum, the RDS field "vacuum" must 

also be flagged. 

Over-specified: 

If there are no Item in the room with the "Yes" field, neither shall the RDS 

field have "Yes". 

Example: If no Item in the room require vacuum, the RDS field "vacuum" 

shall not be flagged. 

 

Numerical Logical Yes Under-specified 

The RDS field must be equal to or greater than the number of Item in the 

room where the Item field is flagged.  

Example: If the Item is flagged for power supply, the number of sockets in 

the room must be greater than or equal to the total of all these Item which 
require power supply. 

Over-specified: 

The RDS field must not be greater than the number of Item in the room 

where the Item field is flagged. 

Example: The number of power sockets in the room must not be greater 

than the number of Item which require power. 

 

Logical Numerical No Under-specified 

If an Item in the room has a field greater than 0, the RDS field must be 

flagged. 

Over-specified: 

If no Item in the room has a field greater than 0, the RDS field must not be 

flagged. 
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Numerical Numerical No Under-specified 

You can choose an operator with which to compare values. If you choose 

Item field must be greater than or equal to the value in 
the RDS field. If you choose Item field must be less 

than or equal to the RDS field. 

Example: The minimum temperature for the Item must be greater than or 

equal to the minimum temperature in the room.  

Over-specified: 

Reverse the operator selected (for under-specified).  

For example: The minimum temperature for the Item must not be less 

than the minimum temperature in the room. 

Check whether over-specified for this type of rule actually has any practical 
significance. 

Numerical Numerical Yes Under-specified 

The sum of the Item field for all Item in the room must be less than or equal 

to the value in the RDS field. 

Example: The number of data connections for all equipment in the room 

must be less than or equal to the number of data outlets in the room. 

Over-specified: 

The value in the RDS field must not be greater than the total of the Item 

field for all Items in the room. 

For example: The number of data connections for all equipment in the 

room must not be greater than the number of data outlets in the room.  

 

Table 1 

Go to Project-> RDS-> Item check to create and delete rules. This provides you with an 
overview of all rules defined. Click on "Add" to add a rule. There is a tree on the left-hand side 
of the screen with all the RDS fields and one on the right-hand side with all the Item fields. 
Choose one field in each of these by double-clicking on the field you want. Depending on the 
type of field you have selected, you will have options as to whether the resource is to be 
counted down and the operator you want to use. Once you have completed defining the rule, 
its definition will be shown in the text fields for under-specified and over-specified 
respectively. You then select a priority and click OK.  

If you want to delete a rule, select the rule and click Delete.  

13.3. Run rules 

You can do this in a number of ways: 

 One rule for all rooms 
 All rules for one room (only under-specified) 

For an overview of rules, go to Project-> RDS-> Item check. The list contains an overview of 
the fields to be checked by the rule and whether the resource is to be counted down or not in 
addition to the comparison operators to be used. Double-click on a rule or choose 
"Properties" to view a textual description of the rule. You can then choose to run the rule to 
check for under-specified or over-specified. If you do not want to run the rule, you can close 
the window by clicking in the left-hand corner or pressing ESC. 

Once the program has checked all the rooms, you will see a result window as illustrated below. 
This contains a list of which rooms have breach of rules (at top level), the Items in the room 
which breach the rule and finally which rules are breached by this Item in the room. There can 
be several Item in a room which are in breach of the rules, and several Item may be in breach 
of several rules, even though this is not displayed in this screen. The rule being breached in 
this example informs us that the Item field for "Water supply" (on the left) is "Yes", while the 
RDS field (on the right) is not.  



USERS' GUIDE, DROFUS 

 

 

 
76 

Figure 44: RDS<-> Item check 

You can right-click on one of the results and then open RDS Item or equipment list to correct 
the error. The rule has to be run once again to view the results of your corrections.  

If you want to run all rules for a room, open an equipment list (ref. chapter 11.3) and then 
select RDS<->Item check. 
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PART 4: FINISHES 
MODULE FOR FINISHES 
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14. FINISHES 

14.1. Introduction 

The finishes form allows you to link project information to a room. This is in principal a 
function intended for covering information from the architect. However, as the form can be 
freely defined, there are no limits to what can be registered. The form can contain fields which 
are calculated on the basis of certain room core information such as area and ceiling height. 
The method of calculation for these fields can be determined project by project. It is common, 
for example, to create a tab for ceiling or floor and for all fields calculated in this tab to be set 
as equal for the designed area in the room core. You can also have fields in a tab for wall 
which are calculated on the basis of ceiling height, room periphery and deduction for wall 
area. All this area information must be updated in the room core and updated for each room. 

As with RDS, the room is either linked to a unique form or a template form. Finishes can be 
linked to both room templates and to covering templates which are later linked to rooms. A 
room may have the following covering status: 

Form not created: The room is not linked to any finishes. 

Unique finishes: The room has unique finishes which only apply to this room. 

Finishes template: The room has finishes from a room template and changes to the 
template are therefore reflected in the room. 

Derived finishes: The room is linked to a form template, but has some fields which do not 
concur with the template. All fields/finishes which are defined in the template must also be 
displayed on the derived form, but may have other values. You can also choose to provide 
information on other finishes than those in the template. Data which deviates from the 
template will be marked with a red asterisk in front of the field. If you hold the mouse cursor 
over the field, you will be able to read any template value set for this field. 

Copied finishes: The room has a unique form, but this has been in principal copied from a 
room template or a template. 

Finishes can be regarded as a hybrid between RDS form and equipment list. Finishes 
comprise the same types of fields as an RDS form but, as with equipment lists, you have to 
choose the fields for which you want to provide information. All fields are displayed at all times 
in the RDS form. 

However, there are some differences from the RDS form which are worthy of notice.  Even if 
you create a room with template or derived finishes, the fields calculated will always be based 
on the room core values for the room in question. These calculated fields do not have any 
significance in a template form, so will be empty or zero for room templates and templates.  

14.2. Creating and deleting finishes 

From the room list (Project -> Rooms), you can link finishes to a room as follows: 

 Select the actual room in the room list, or select several rooms by using the Ctrl/Shift 
keys. 

 Right-click then go to finishes and choose the link you want, or choose Room -> Finishes 
from the menu then choose the link you want. 

 If you want to delete a form, follow the procedure above but choose "Delete covering". 
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When you create a room template, finishes are automatically linked to the room. 

14.3. Open finishes for editing/reading 

From the room templates window (Project -> Room templates): 

 Right-click on the room template you want and choose finishes. 

From the room list (Project -> Rooms): 

 Right-click and choose Finishes. 
 Or go to the menu and click Room -> Finishes. 
 Or choose finishes from the toolbar. 
 
Or covering templates (Project-> Finishes templates). 

14.4. Finishes 

The illustration below shows an example of a finishes form. 

 

Figure 45: Example of Finishes form (N.B. Norwegian text) 

The toolbar has the following options: 

 The Next/Previous button displays the finishes for the next and previous room which has 
this type of form at the level you have selected in the room list. You can also use the 
drop-down menu (by clicking on the small arrow beside the button) to jump directly to 
rooms further forward or backward in the list. 

 Add finishes. Ref. explanation below. 
 Print - to generate a report with this form. 
 The Finishes log button displays changes made to the room. 
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 The Copy from button (only available for unique and copied rooms) allows you to copy a 
form from another room. With this menu, you can also choose to copy the form to other 
rooms which either have a unique form or do not have a form. In the latter case, a unique 
form will be created. To choose the room you want to copy the form to, open the dialogue 
box with rooms. Select the rooms you want to copy to by scrolling through the function 
structure to find the rooms you want.  

 Note: Displays and allows for editing of a comment/note to this form. 
 Date: This field is available if there is a log for the room. You will then be able to view the 

form for a specific date. It is not possible to choose dates which come before or after the 
log input was made. After you have chosen the date, fields which have been changed 
since that date will be marked with a blue asterisk. 

The status field shows you when a form link was created for the room and when form data, for 
the room, was last amended. You can also read what kind of link the form has to the room. 

Add finishes 

As opposed to the RDS form, when in finishes mode you have to choose the fields for which 
you want to provide information. This is because there are often numerous finishes and in 
general you only want information on the 
finishes to be used in the room. Add 
finishes either from the toolbar, by right-

clicking in the window or clicking on . You 
then choose fields/finishes from a dialogue 
box, as illustrated on the right. The fields 
you can use are defined project by project. 
The top drop-down menu defines tabs or 
main groups. These are often floor, ceiling, 
wall etc. You can select more than one by 
using the Ctrl or Shift keys.  

 button used to remove a covering which 
is no longer relevant for the room.  

NB! If you make use of a derived covering for a room, you are only able to remove the 
finishes which are entered as unique for this room. You can enter other values for 
finishes which originate from the template. If you therefore want to change a covering 
in a derived room, you have to add the new covering and set values which show that the 
template is not utilized (e.g. set area to 0). 

14.5. Reports and exports 

Not only can you read information on finishes from the program, you can also prepare two 
reports/exports: 

1. You can generate a finishes form per room by the persons carrying out the work on 
the room. This report is available from the report overview or by using the Print 
button directly from the finishes form. 

2. You can extract all data from the finishes and export directly to MS-Excel. Using 
Excel, you can filter, sort and total the information as required. There is no special 
function to sum up the use of e.g. a material in dRofus. The program is designed so 
that this is performed using the export function. 

                     Figure 46 
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PART 5: LOGS AND REPORTS 
SHARED FUNCTIONALITY FOR ALL MODULES 
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15. LOGS 

15.1. General information on logs 

All changes to information in the program are logged. This provides a complete control of 
change history. The logs are divided according to their contents, i.e. room core information is 
logged in one log, RDS in another, changes to equipment in room in another log etc. The 
system administrator can choose to deactivate and activate logging for the different parts of 
the program.  

15.2. Log window 

The log can be opened from the majority of windows where changes are logged. The log will 
then be displayed for the room/Item in question etc. The log can also be opened from the top 
menu Log-> Logs. 

In this window, the log is divided into 7 parts; 

 Room 
 Room template 
 Groups 
 Function program 
 Item 
 Existing equipment 
 TIDA 

Once you have chosen the type of log you want to search in, you can filter further using 
Logs/Events. If for example you only want to see changes to RDS, then you select RDS. You 
can also filter data from a specific tab in the RDS form and finally a specific field under this 
tab. If you want, for example, to view all the changes to RDS over the past month for room in 
function 15 for fields which involve Electro, you do the following: Choose RDS log in the Log 
field, type in 15 in the no. field to limit the filter to the rooms you want. Enter "El" in field to 
choose the correct fields then finally enter the last month under from date. Figure 34 below 
provides an example of the above. 

You can use Log data filter to search for the log entries in which you are interested. You can 
use * as a wildcard to allow searches for free text.  

Text can be linked to all log entries. The text may be for example a comment to why the 
change was made or the minutes of the meeting when the change was adopted. You can 
choose one or more log entries and type in comments in the comment field. You can then 
search for this text if you want, for example, to view all changes related to a specific reason or 
set of minutes. 

Tip: You can also search through all the logs at the same time. To do so, choose 
"Search in all" then choose log type. The logs in which the different log entries are 
displayed are shown in the Log column.  
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Figure 47: Example of change log for a specific RDS field 

The quick diff option in the lower right section of the log window allows you to see only the text 
that has been changed. This is especially useful when changes are made to long strings of 
text so you can easily see what has been changed. Deleted text will be highlighted with a red 
line through the deleted text. Additional text will show in green.  

If you want to see the full string of text with changes highlighted select the tab . Old 
value and new vale can also be viewed in tabs. 

15.3. Log with change list 

You can use change lists to structure the changes made in dRofus. Changes will be 
automatically linked to a change list in which information is easily filtered in the log window. If, 
for example, you want to make a set of changes related to a user meeting, design meeting, 
building meeting etc., it may be beneficial to link these changes to a change list so that you 
can easily search for the data in the log window. 

To start a log with a change list, go to Log-> Start logging with change list.  

 

Figure 48  

The window which appears will show you all change lists previously created for the project. 
You can either choose to link the changes you are about to make to an existing change list or 
create a new change list. To create a new change list, click on New and type in a name or 
number for the change list.  
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Figure 49 

This name will then appear in the log window under Change list. You also have the option to 
type in a log note which is automatically saved in the note field in the log for all changes you 
make for this change list. Then click OK. Please note that only changes to function program, 
room, RDS and finishes are logged in the change list, not equipment. 

All changes you now make will be marked with the name you assigned to the change list, and 
this will continue until you decide to end logging with change list. Go to Log->Stop logging 
with change list to close the change list. Now that you have a set of changes marked with a 
change list, you can go to the log window, choose the log you want to view, go down to Change 
list and choose the one you have created. All changes related to the change list will be 
displayed in the list on the left (figure 41). 

 

Figure 50: Filtering a change list 

You can also connect a change to a changelist without first Start logging with 
change list In the RDS, room core or equipment list you can use the dropdown menu besides 

ist or a lognote; 
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Figur 51: Add change to changelist or lognote 

15.4. Log with log note 

As with logging with change list, you can also make changes where you automatically include 
a log note for the changes made to the database. To start a log with a log note, go to Log-> 
Start logging with log note. In the new window, type in the note you want to appear in the log 
note in the log. To stop this operation, go to Log-> Stop logging with log note. 
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16. PICTURES/DOCUMENTS 

16.1. Pictures 

Pictures can be moved to different parts of the program. This applies to Item, existing 
equipment, rooms and in the function program. Pictures can be used to explain the 
appearance of Item, provide sketches or drawings of rooms or photographs of equipment to 
be transferred.  

 

Figure 52: Extract from the Item window, with the "Pictures/Documents" tab selected 

The table below explains what the buttons on the right-hand side mean. The same options 
are also available by right-clicking in the Pictures/Documents tab. 

Icon Definition 

 

Go to next picture. This will only be available if more than one picture is registered. 

 

Go to previous picture. 

 

Delete current picture. 

 

Add pictures.  You can choose to add pictures with the following formats: GIF, JPG, TIF, PNG and BMP. You 

can add several pictures at one time. If the pictures are very large, or in another format than GIF or JPG, 
they will be converted before being downloaded to the database. See also tips below. 

 

Copy to the clipboard. The picture selected is copied to the clipboard so that you can copy it into other 

programs such as Word or image processing programs (instead of using Edit-> Paste or Ctrl-V). 

 

Allows you to save the picture which is displayed as a separate file. 

 

Displays the picture in a new window for full size display. This also occurs if you double-click the picture. 
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Tip: Pictures can also be added by using the drag and drop technique. To make work 
quicker, you can use a file manager and click on the pictures you want to create links 
for, hold down the mouse button, then drag and drop over the picture tab. 

Tip: The above technique can be used directly from web pages. If you want to add a 
picture from a website, you can click on the picture in Internet Explorer or other 
browser then drag and drop it over into the Pictures/Documents tab.  

If you have problems uploading certain pictures, it may be that they are in a format which the 
program does not recognize. You can try opening the picture in the file manager
function then save it as a JPEG before trying to upload it once more. 

16.2. Documents 

Documents and files can be linked to different data in dRofus, such as rooms, Item, tenders 
etc. Documents linked will be saved to the database on the central server so that they are 
available to all those who log in, irrespective of location. Depending on the speed of your 
Internet connection, it may take some time to upload and download large documents. Try 
therefore to minimize the size of the documents you upload.  

You can upload documents either by dragging and dropping them over the window, or clicking 
on "New" from the right-click menu or toolbar. You can change the document name and add 
a description of the document by double-clicking on it or clicking on "Properties". In order to 
save one or more documents to your local hard disc, you select the documents you want and 
choose "Save". You can also choose to open a file directly if you have a program which 
supports displaying the document, and choose "Open". 

Icon Definition 

 
New document 

 
Open document directly 

 
Save the document(s) to your local hard drive 

 
Delete the document from the server 

 
Show document properties 

 
Change view for document list 

 

WARNING: If you want to change a document, you have to save it first, change the 
document then upload it once more. Changes to documents you have opened directly 
will not be saved on the server if you do not upload the document once more. 
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17. REPORTS 

dRofus offers several types of reports which are suited for print-out, storage or distribution 
via email. All reports are generated in PDF format.  

All data in dRofus is stored on a central server, which also generates reports and sends these 
back over the Internet. It is advantageous to limit the number of reports generated if possible. 
The reports generated for e.g. all rooms in the project naturally take a much longer time than 
reports for individual rooms. When you request a report, an Internet browser will automatically 
open showing the status for report generation and, finally, the report itself. If this takes a long 
time, you can continue working with dRofus while you wait.  

The majority of reports are available directly from most windows (e.g. room list and RDS 
window). For more information on this, read the respective chapters. 

All the reports are available from the report window, which can be opened from the following 
menu: Project->Reports->Reports. This excludes reports for specific RDS information and 
Item specifications (ref. 17.3) which are opened from Project->Reports->Report, selected 
RDS information and Project->Reports->Report, chosen Item specifications. 

On the left-hand side of the window, the reports are categorized in a tree structure. 
Paragraph 17.1 provides a general overview of the restrictions and potential for expansion for 
reports. Paragraph 17.2 provides a brief overview of the different reports. Please note that not 
all reports may be available for each project, and that new reports and restrictions may 
emerge. 

17.1. Report restrictions/expansions 

For most reports, you have options to expand a report 
and introduce restrictions to the selection you want. 

Restrictions 

Many of the restriction options exist for a number of 
reports. An overview of restriction options is provided 
below. 

 Level restriction, allows you to limit the report to only apply to selected levels. To do so, 

click on the folder ( ) then make your selection in the tree window. Click on the cross 

( ) to remove your selection.  

NB! It is not sufficient to just select one level, you have to click in the box beside it so 
that a cross appears.  

Tip: If you want to select an entire level with sub-levels, all you have to do is select it (do 
not need to click on all sub-levels). The figure provides an example. 

Figure 53 
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 Item/Room restrictions, allows for 
restrictions according to individual Item or 

room. Click on the folder ( ) to open the 
same window as when copying 
RDS/equipment. As opposed to level 
restrictions, you can type in the function 
number(s) for the rooms/Item for which you 
want to introduce restrictions. Please note 
that you have to click on the level under 
which you want to find the room first, then 
the program will display the rooms under this 
level. If you want to enter more than one 
function number, use commas to separate. 

You can also type in a series of numbers and separate them with a hyphen or a 
combination of characters. For example, 01.01.001,01.02.001-01.02.004 is a restriction 
for 01.01.001 from and including 01.02.001 to and including 01.02.004. Click on the 

cross ( ) to remove your selections. 

NB! Remember to make sure there is a cross in front of the Item/rooms you want to 
include. 

 Date restriction You can also introduce restrictions by date for all log reports. You 
choose this option from the calendar. 

 Specification restriction Under Choose specification, you can restrict according to 
certain fields within the Item specification, RDS or finishes. For more information, ref. 
17.3. 

 Limit fields This allows you to limit the groups of fields to be included in RDS, Item 
specification and finishes report.  

 Other restrictions In addition, there are a number of other restrictions available, e.g. only 
utilized Item in the project, restriction according to RDS type, responsibility group, priority 
and budget group. 

Expansions 

In addition to carrying out restrictions, the majority of reports can also be expanded in the 
sense that you "merge" several reports into one. This applies to two areas in the main: 

With log When you click on this option, you can choose to merge a log with a report; for 
example, you can click on this option in the RDS report so that the RDS log for a room will be 
merged with and will be displayed after the RDS for a room. 

With Item/room In the function structure, cost of equipment in room and Item per function 
group, you can choose to include rooms and Item in the function structure. 

With occurrences Includes occurrences of equipment in a room in the Item specification 
report. 

17.2. Overview of reports 

Numerous reports are available and it is easy to lose control of the different types and from 
where they are generated. As the reports change and new reports constantly emerge, we do 
not have a complete list of available reports. Below are some examples of the reports 

Figure 54 
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available in the different categories in the report overview. The best method is to try out the 
different reports so that you can become familiar with them.  

Room template 

This report provides a list of room templates and contains information related to room 
template. It includes RDS templates, equipment list templates, covering templates. The 
program also has separate log reports for room templates. You will also find lists of the rooms 
which are, in one way or another, linked to a room template. A special report is also available 
for listing rooms with derived RDS values and their original standard values. 

Templates 

The same reports as for room templates, but for the different types of template. 

Room 

All the reports on rooms and related information. Room lists with total area, RDS, finishes, 
equipment lists and logs. 

Item 

Reports regarding Item and equipment, e.g. different types of Item lists, Item specifications, 
occurrences of Item in rooms, existing equipment linked to a room, sub Item and logs.  

Procurement 

Reports related to procurement and purchasing of equipment. 

Calculations 

The calculation reports summarize the costs of equipment in room grouped in a number of 
different ways. 

17.3. Reports on selected RDS information / Item specifications 

Certain reports allow you to specify values for RDS information / Item specifications and 
generate reports on the rooms/Item which meet these requirements. You can, for example, 
generate a room list for all rooms which have the RDS field "Other requirements for door 
opening: YES".  

In the restrictions window for a selected report, e.g. RDS report, click on Choose specification. 
This screen displays all the fields grouped under the tab in the tree on the left. Do the 
following: 

1. Choose one of the fields by clicking on/in it. The field will then be displayed on the 
right.  

2. You also have two options for restrictions. First, choose the type of restriction, e.g. 
"Equals", "Not equals", "Greater than" etc. and the value to be checked against. If you 
have chosen a logical field, you have the option to restrict withdrawal for the rooms 
which have Yes or No for this field. If you chose a numerical field however, you can 
specify if the field shall be greater than, less than, equal to or not equal to a specific 
numerical value. Choose the value you want. 
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3. You can now choose to select several fields in order to further restrict/expand your 
selection. To do so, click on the plus sign at the very far right. If you want to remove a 
restriction, you can click on the minus sign. You can specify whether you want all the 
criteria to be met or if it is sufficient with just one.  

4. Click OK to generate the report. 

 

Figure 55 

Requests of this type can also be saved for later use. To do so, click on Save. You can then 
reopen this later by going to "Saved filter". 

17.4. Printing and saving reports 

Once a report has been generated, the report is opened in your default PDF reader, e.g. Adobe 
Acrobat Reader. 

From here, you can print it out by clicking on the printer icon  or going to the menu File-> 
Print. If you want to save the report so you can, e.g. send it by email to others or read it a later 

date, you click on the diskette icon . 

17.5. Editing and saving reports in other formats 

As previously mentioned, all reports are generated in PDF format and can be read in Adobe 
Reader or other document readers which support this format. There are also programs in 
which you can edit and export PDF files. These are not free however. The most commonly 
used is Adobe Acrobat. With this program, you can edit and change PDF documents, merge 
several documents and a number of other functions. 

In version 6 of Adobe Acrobat, you can export PDF files to e.g. Word or Excel format. To do so, 
go to Save as from the menu and choose the format you want. Please note that the 
documents will probably not retain the same appearance as the PDF format, unfortunately. 

If you want to extract certain data to an Excel spreadsheet, you can do the following: Select 
Table selection tool from the toolbar and select the table/data you want to export to Excel. 
Then you can either double-click the selected area (which will start Excel), or right-click and 
save the selected area in Excel format. 

For users with Adobe Reader, the potential for export is more limited. You can save the 
documents as plain text by selecting File->Save as text. You can also use Copy and Paste. Go 
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to Select text from the toolbar and select the text you want to copy into another program. 
Then go to Edit->Copy or press CTRL+C. Then open the program you want to copy the data 
into, e.g. MS Word and go to Edit->Paste or press CTRL+V. This will not retain the text format. 
For that, you need a full version of Acrobat (standard version 6 or 5).  

17.6. Other reports in MS-Excel 

dRofus AS has, on request from the project, created a number of reports  particularly for 
finance and costs. These are based on MS-Excel and data generation from a dRofus server. 
They are not generated directly in dRofus but are separate spreadsheets which identify and 
upload the data needed. You will find the spreadsheets here: 
http://www.drofus.no/index.php?page=excel 

17.7. Save report setup as project report 

You can save your frequently used PDF reports as a new project report. After setting your 
desired limitation and expansions to the setup you can chose to save the report by clicking 

 

 
Save report 

After you have done your selection you can give your report a new name and description and 
decide whether or not you want to share the report with other dRofus users.  

templ
http://drofus.no/assets/files/Documents/user%20documentation/dRofus-XFDesigner-
UserGuide.pdf.  

 

http://www.drofus.no/index.php?page=excel
http://drofus.no/assets/files/Documents/user%20documentation/dRofus-XFDesigner-UserGuide.pdf
http://drofus.no/assets/files/Documents/user%20documentation/dRofus-XFDesigner-UserGuide.pdf
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Give your report name and description 

Your 
and description: 

 

Saved reports are place in the folder «Project reports» 

Export saved report to xml 

When you select a saved report and check the More options  checkbox, you are able to select 
another format than PDF for the report. If you select XML you are able to generate an xml file 
that contains the same data as the one used when generating the PDF report. This is useful if 
you are using a custom template and you want to alter it. You can then get an updated version 
of data from the database without having to first configure the built-in report the same way 
as the saved report is configured. 
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Copy a project report 

After creating a saved report you can make a copy of it. To do that, right click on a saved 

Project report folder. 

 

Image 56: Make copy of project report 

17.8. PDF Batch reporting 

PDF batch reporting allows you to easily create individual reports for one or more items. An 
item can be a room, room template, template, Item or finish. Say you want to create one PDF 
report for each room in a room function. You select the Room Data Sheet report, select the 
room function and then change the format from PDF to PDF Batch. 

 

Figure 1: Shows how to start a PDF Batch report 
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When the PDF Batch report is started, a web page showing you the progress will be shown in 
your default browser. All the individual PDF files will be created on the server and added to a 
zip file. The zip file will be automatically opened when the report is finished. 

 

Figure 2: The result of a PDF Batch report 

 

Customizing the naming of files 

It is possible to configure the naming of the individual files. The default naming is using the 
item number, such as room function number for rooms, room templates and finishes and 
Item number for Item. However, this can be changed. If the project is using a special 
numbering scheme for rooms, e.g. by using an extra room core field, you can create a saved 
report and configure it to use this numbering scheme. The procedure for this can be error 
prone so we recommend you contact your dRofus support for help regarding this. 

17.9. Project/custom PDF reports in room windows 

When you create and save a project defined report, the saved reports will also show in 
different room windows in dRofus so they can be used directly for e.g. an open room data 

added to the list; 
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Figure 57 (above): Saved report in "Reports and exports" available directly in room RDS window 

Where the saved reports are shown depends on what type of report is being saved. E.g. all 
Room Data Sheet reports will show in the room RDS. All Template Room Data Sheet reports 
will show in the template RDS. Saved equipment reports will show in Equipment in room etc.  



USERS' GUIDE, DROFUS 

 

 

 
97 

18. EXPORTING DATA 

18.1. Exporting data to MS-Excel and MS-Word 

The program can export certain data to Excel format so that it is easier to sort and filter data 
yourself. Exporting data implies that you save data in a different data format than that 
originally saved in the system. Please note that exported data cannot be imported back to the 
program.  

The following data can be exported to Excel: 

 Rooms and room data sheets 
 Function program 
 Item specifications 
 Equipment in room 
 Finishes in room 
 All lists in the program (see below) 

 

The export is carried out by an export wizard which guides you through the options you have 
and restrictions you have to make. You start the wizard by going to the Project->Reports and 
exports menu or Reports and exports directly from the start window. You then select the 
required type and export.  

Please note that export may take some time and it may be beneficial to make some 
restrictions if you are not interested in all the data. 

Save Excel exports 

After you have done your selections you can save the setup in your Excel export. This can be 
done if you have data that you are exporting frequently. You can decide whether or not you 
want to share the saved export setup. 
export with some modifications to the data fields. I.e. we have added a few RDS fields. You can 

 To save your Excel export, first do all your 
selections and data field  
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Figure 58: Save Excel export 

Give your custom Excel export a name and description, and decide to share it with other 
dRofus users or not: 

 
Figure 59: Enter name and description 

 Title: Title of the Export 
 Description: Written description of the export 
 Shared: If you tick this option all dRofus users in the project will be able to access the 

export. If not the export is stored locally. 
 

Your n
window. 
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Figure 60: New export under "MS Excel Project exports" 

To run your new export, select it under MS Excel Project exports. All predefined selections will 
 

Excel export with template 

The Excel export supports use of templates. You can create your own custom Excel template 
and upload it to the server. dRofus can export data to the custom template. An Excel template 
file can be any Excel file format (xls, .xlsx, .xlt, .xltx). You can decide in what cell you want to 
start to write in the spreadsheet and whether or not you want to export dRofus headings. If 
you have 

 

An excel template file can contain one or more pivot tables. When an excel export is 
generated using a template file, all pivot tables in the template file are automatically 
refreshed. Note that the pivot table must be in another sheet than the one you select to write 
data to. 

Figure 61: Export to Excel with template 

Lists for Excel 

All list windows in the program can be exported to Excel, such as room list, Item list, log etc. 
When the cursor is in the list, press CTRL+E. This exports the data in the list to Excel format. 
You will need to have Excel installed on your PC to do this. 
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Lists for Word 

Similarly, you can also export tables to MS-Word. To do so, place your cursor in a list and 
press CTRL+W. You will need to have Word installed on your PC to do this. 

Tabs for Excel/Word 

Certain windows with tabs and windows allow export of all values to Excel or Word. This 
applies e.g. to the RDS window, Item specification and procurement windows. Right-click in 
the window and select export to Word or Excel. In windows with several tabs, you can also 
choose to click in the window in which the tab is located and then export all tabs to the same 
document/spreadsheet. You will also have the option to select the tabs you want to export. 

 

Figure 62 

18.2. Export to XML 

The reports are generated on the basis of XML, so that all data in the reports can also be 
produced in XML format. XML is well suited for import to other computer systems. It is not as 
suited for import to user software such as Office applications etc. XML of data can be 
produced on request, for example when concluding a project.  

18.3. Export to IFC 

dRofus supports export of data to the international IFC standard. IFC support in dRofus is 
described in a separate document, IFC Support in dRofus, which is available from 
http://www.drofus.no.  

18.4. Export to NS3459 

dRofus supports export of Item to NS3459. This is available under the following menu: 
Project-> Reports and exports-> Other exports. Exports can be utilized in programs such as 
G-PROG and Focus Anbud. The export is best suited if you make use of the potential for 
NS3420 coding of Item, ref. Wrong! Reference source not found... 
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19. IMPORT AND EXPORT OF DATA 

19.1. Import rooms from MS Excel 

You can import rooms, room data structures, room core information, groups and RDS data 
into dRofus from Excel by going to dRofus->Import/update and choosing Import room. This 
will open a window where you can choose an Excel file from your computer. Once you have 
done this, dRofus will automatically suggest the first row of data and check whether the 
program recognizes the column name which matches either with room core fields, group 
names or RDS fields in dRofus. This is only intended as a suggestion and must be double 
checked with the Excel spreadsheet before running the import. You must also check that the 
correct worksheet has been specified. 

The Excel spreadsheet must have a specific structure to allow import. It is important that the 
number and name of functions and sub-functions are entered in different columns, although 
they do not have to be in a sorted sequence - if a level is repeated later in the document, 
dRofus will see if it is found and then make use of the existing one. It does not matter which 
columns contain data, but you have to specify this yourself in the import dialogue box. Only 
the columns specified for import will be read. Even if you have other information in the 
spreadsheet, it will not be read. 

You can specify which rooms to import in two ways: If you have more than one room per row, 
you have to specify this in a separate column and cross off number of rooms. dRofus will then 
only import the rooms which have a number greater than or equal to 1. Rows with blank 
numbers of numbers less than 1 will be ignored. If you cross off for number of rooms, the 
import function will check the entry in the name column and then import the rows which do 
not have a blank/empty name. 

An example of how this process works is provided in the illustration below. 

  

Figure 63: Explanation of the process to import rooms 

Excel spreadsheet 
 

The "import room" dialogue box where 
the columns from the Excel spreadsheet 
are mapped with the room core fields in 
dRofus. Only the columns which have 
been marked and given a value will be 
imported. 

The result shown in the 
room overview in dRofus. 
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The fields for Function level illustrated in his example in the Import room window may vary 
from project to project, depending on how many function levels are defined for the project and 
their names. 

Click the RDS button to import RDS fields. This will open a dialogue box with all defined RDS 
fields and you can choose which fields you want to import. The program tries automatically to 
match column name to RDS fields. This will succeed if the column name is written in the 
following format: <tab name> - <group name> - <group element name> - <field name>. It is 
important here to check the RDS tabs in dRofus to make sure that the text is entered 
correctly. For example, the column name "Description - Personal load - Persons, maximum" 
is mapped to the Description tab, the Personal load group and the Persons, maximum group 
element. 

19.2. Import dynamic data (RDS/Equipment specifications) 

If you want to include i.e. RDS data in a room import
Item import. A dialogue bow will open with all the data fields in the 

database. You can import data to all of these by inserting the Excel column letter in the  

automatically map data fields to the correct column in Excel. 

 

Note that dRofus uses different types of data fields for different kind of information. I.e. 
 

19.3. Updating rooms from MS-Excel 

Room information can be updated directly from an Excel spreadsheet, such as a list of 
updated areas exported from a CAD program. The room data sheet number must be entered 
in the Excel spreadsheet. New rooms cannot be imported but must be created manually first 
in order to have a room data sheet number assigned.  
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In order to start the import, go to the menu for dRofus->Update rooms from MS-Excel.   

 

Figure 64 

Click on the first file you want, or a spreadsheet if the data is not in the first spreadsheet. You 
must also specify the row in the Excel sheet from which you want to start importing the data. 

The next step to take is to specify which columns in the Excel spreadsheet contain the data 
you want to update. You must specify the Excel column (A-IV) which contains the room data 
sheet number as this is used as the entry key in dRofus. After that, you can choose the data 
you want to be updated (mark the check box). The other columns in the Excel spreadsheet will 
be ignored. They will only be updated as a change if the value is not equal to the value already 
in dRofus. 

Then choose Start. After the import has completed, you will receive a report of any errors and 
how many rooms have been updated. You can also open the room history log to see changes 
made. 

Click the RDS button to import RDS fields. This will open a dialogue box with all defined RDS 
fields and you can choose which fields you want to import. The program tries automatically to 
match column name to RDS fields. This will succeed if the column heading is written in the 

 

Tip: If you make use of the same background text as in dRofus (use Excel export as 
template), the program will automatically recognize what data is located in which 
column. You have to flag columns to specify what is to be updated. 

Tip: If you only specify room data sheet number and no other columns, the import will 
only go through the Excel spreadsheet to see if it finds the room or not, e.g. to check 
valid function number in relation to export from drawing.  

NB! Areas and sizes in dRofus are specified in meters. Exports from CAD often specify 
in millimeters. You must therefore remember to convert these two meters before 
importing. 

19.4. Import and update of equipment in room from MS-Excel 

You can both import and update equipment in room into dRofus from Excel by going to 
dRofus->Import/update and choosing Import/update equipment in room. This will open a 
window where you can choose an Excel file from your computer. The file must contain data to 
identify existing rooms and existing Item and data to create a new or update an existing 
occurrence. 
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You can choose to either just import equipment which does not already exist, only update 
existing equipment or both. When you only import new equipment, all occurrences which 
already exist are ignored. When you only update equipment, all occurrences which do not exist 
are ignored. 

You have to select the way in which the rooms are to be identified, for example, by specifying 
their room data sheet number. You also have to select the way in which the Item are to be 
identified, for example, by specifying their Item number. 

Once you have specified the Excel file, dRofus will automatically suggest the first row of data 
and check if the program recognizes the column name which matches the selected 
identification type for room and for Item. This is only intended as a suggestion and must be 
double checked with the Excel spreadsheet before running the import. You must also check 
that the correct worksheet has been specified. It does not matter which column the data is 
entered in. Only the columns specified for import will be read. Even if you have other 
information in the spreadsheet, it will not be read. 

19.5. Import and update of room templates from MS-Excel 

You can both import and update room templates, room template core information, groups 
and RDS data into dRofus from Excel by going to dRofus->Import/update and choosing 
Import/update room template. 

This will open a window where you can choose an Excel file from your computer. Once you 
have done this, dRofus will automatically suggest the first row of data and check whether the 
program recognizes the column name which matches either with room core fields, group 
names or RDS fields in dRofus. This is only intended as a suggestion and must be double 
checked in the Excel spreadsheet before running the import. You must also check that the 
correct worksheet has been specified. It does not matter which columns contain the data, but 
you have to specify this yourself in the import dialogue box. Only the columns specified for 
import will be read. Even if you have other information in the spreadsheet, it will not be read. 

You can choose to either just import a room template which does not already exist, only 
update existing room templates or both. You also have to choose how to identify the room 
templates if they are to be updated, for example via their code. If you only import new room 
templates, all room templates which match existing room templates in dRofus will return an 
error message and the operation will be terminated without the data in dRofus being 
changed. The same will occur if you only want to update room templates but one or more 
room templates do not match the existing room templates in dRofus. 

Click the RDS button to import RDS fields. This will open a dialogue box with all defined RDS 
fields and you can choose which fields you want to import. The program tries automatically to 
match column name to RDS fields. This will succeed if the column name is written in the 

 

19.6. Import finishes to rooms from MS Excel 

You can both import finishes data to  room templates and rooms by going to dRofus-
>Import/update and choosing Import/update finishes. 

This will open a window where you can choose an Excel file from your computer. Once you 
have done this, dRofus will automatically suggest the first row of data and check whether the 
program recognizes the column name which matches with room core fields in dRofus. This is 
only intended as a suggestion and must be double checked in the Excel spreadsheet before 
running the import. You must also check that the correct worksheet has been specified. It 
does not matter which columns contain the data, but you have to specify this yourself in the 
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import dialogue box. Only the columns specified for import will be read. Even if you have other 
information in the spreadsheet, it will not be read. 

You also have to choose how to identify the rooms/room templates for example via their code 
or room function number. 

Click the Finishes button to import Finishes data. This will open a dialogue box with all defined 
finishes fields and you can choose which fields you want to import. The program tries 
automatically to match column name to finishes fields. This will succeed if the column name 
is written in the  

19.7. Import documents to rooms 

You can import documents to Rooms by selecting dRofusImport/UpdateImport room 
documents. You must have your documents in a folder which you select using the browser 

must be named either with Room function number, Room number, User room number or 
Room ID. So you need to name your documents like this (If you use Room function number as 
identification): 01.01.001.doc.  

If you use a character to separate name and number in the document name, you can identify 

document name-
and number:  

 

19.8. Import and update of equipment to room templates from MS-Excel 

You can both import and update equipment to room templates into dRofus from Excel by 
going to dRofus->Import/update and choosing Import/update equipment to room templates. 
This will open a window where you can choose an Excel file from your computer. The file must 
contain data to identify existing room templates and existing Item and data to create a new 
or update an existing occurrence. 

You can choose to either just import equipment which does not already exist, only update 
existing equipment or both. When you only import new equipment, all occurrences which 
already exist are ignored. When you only update equipment, all occurrences which do not exist 
are ignored. 

You have to select the way in which the room templates are to be identified, for example, by 
specifying their code. You also have to select the way in which the Item are to be identified, for 
example, by specifying their Item number. 
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Once you have specified the Excel file, dRofus will automatically suggest the first row of data 
and check if the program recognizes the column name which matches the selected 
identification type for room template and for Item. This is only intended as a suggestion and 
must be double checked in the Excel spreadsheet before running the import. You must also 
check that the correct worksheet has been specified. It does not matter which column the 
data is entered in. Only the columns specified for import will be read. Even if you have other 
information in the spreadsheet, it will not be read. 

19.9. Import of Item from MS-Excel 

You can also import a list of Item to dRofus in the same way as you import rooms. This may be 
beneficial when there are numerous Item to be created. The Excel spreadsheet requires a 
specific structure if dRofus is to place the Item correctly in the Item structure. The number 
and name of the main level and sub levels must be entered in separate columns such as for 
rooms (ref. chapter 18.1), followed by a list of Item below. To view the fields which can be 
imported from Excel, go to dRofus->Import/update->Import Item. Follow the same 
procedure as for rooms by mapping the fields you want to include in the import to the 
columns in the Excel spreadsheet. 

Click the Specification button to import Item specification fields. This will open a dialogue box 
with all defined Item specification fields and you can choose which fields you want to import. 
The program tries automatically to match column name to Item specification fields. This will 
succeed if the column name is written in the same way as in the c
dialogue window. 

19.10. Updating Item from MS-Excel  

Item information can be updated from Excel. To view the fields which can be updated, go to 
dRofus->Import/update->Update Item. First, generate a list of Item by searching in the Item 
register, or by selecting a main level or sub level. You use the * wildcard in the quick search 
function then press Enter to generate a list of Item. If you want to include several fields in the 
export, right-click in the room list and select Add/Remove columns. Select the fields you want 
to see and click OK. Once you are satisfied with the display in the Item register, select a line in 
the list and export to Excel by pressing Ctrl+E. You can now make changes to the fields in 
question, save the document and update it by using the Update Item function.  

You can decide either to use the Item number, Item name or BIM-id as an identifier to find a 
Item in dRofus.  

You update Item specification fields in the same way as for import of Item (ref. chapter 19.6). 

To import Item specification fields press the Specification button. A dialogue with all defined 
fields will then appear and you can choose which fields you want to import. The program tries 
to automatically match the column names to AS fields. This will work if the column name is 
similar to the text shown in the column called 'Excel label' in the dialogue window. 

19.11. Import of existing equipment 

Existing equipment is imported from Excel in practically the same manner as for rooms 
(above). Data from the Excel spreadsheet will be added to the register. You cannot update 
data from Excel, only add new equipment. To start the import, right-click in the overview of 
existing equipment and select Import from MS-Excel. Follow the same procedures as for 
rooms.  
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19.12. Import documents and images to Item 

Documents 

You can import documents to Item by selecting dRofusImport/UpdateImport Item 
documents. You must have your documents in a folder which you select using the browser 

must be named either with Item number, Name, BIM ID or Reference. So you need to name 
your documents like this (If you use Item number as identification): 01.01.001.doc.  

If you use a character to separate name and number in the document name, you can identify 

document name- n insert a hyphen (dash) character to separate name 
and number:  

 

Images 

You can import images to Item by selecting dRofusImport/UpdateImport images to 
Item . You must have your images in a folder which you select using the browser icon. If the 
fo images must be named 
either with Item number, Name, BIM ID or Reference. So you need to name your images like 
this (If you use Item number as identification): 01.01.001.doc. 
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20.  IFC (INDUSTRY FOUNDATION CLASSES) 

20.1. Information on IFC  

Industry Foundation Classes (IFC) is an international standard for exchange of data in 
building projects between different computer programs. This provides new potential for data 
exchange and interaction between all types of programs involved in the building process. 
Examples of areas of utilization are data exchange between different CAD programs, checking 
building regulations directly from drawing data, calculation of design information and delivery 
of documentation.  

For more information on the standard and standardization work, and for documentation of 
the standard, go to http://www.iai-international.org or http://www.iai.no.   

Although the standard does not focus on early stage and programming, rather on design and 
drawing, dRofus has the capacity to export a certain amount of key data which can be 
imported to other programs and for consistency checks with other data used in a building 
project. Data exported from dRofus may be used by all programs which support IFC; a 
growing number.  

The most interesting area of utilization for such checks is the control and update of plan data 
in dRofus in relation to drawings in CAD, during the design period. This may comprise control 
of a room which has been drawn, updating a designed area in dRofus in relation to drawings, 
and checking that equipment drawn complies with the plan. dRofus can import data from IFC 
files (STEP part 21 format) and carry out such controls and updates.   

20.2. Use of IFC in dRofus 

The use of IFC and dRofus is described in a separate users' guide, IFC support in dRofus. 

http://www.iai-international.org/
http://www.iai.no/
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21.  USER SUPPORT 

21.1. User support 

This document has been prepared to answer the majority of questions regarding program 
functionality. If you still have questions after having read the chapter you are interested in, or 
you feel the document is incorrect or lacking, please let us know: 

Email: support@dRofus.com 
Telephone: +1.800.541.4890 

All user support not included in this document requires clarification with individual projects. If 
the project has its own user support function/system supervisor, please contact them first.  

21.2. Reporting errors and defects 

You can report errors, defects and preferences regarding functionality in dRofus from the 
Help->Submit error report menu. You can also follow-up the development and status for the 
error reports within your project from the Help->List of errors/bugs menu. 


